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Introduction 

Trns•port and the Trns•port Suite of Software 

Trns•port is the American Association of State Highway and Transportation Officials 
(AASHTO) information system for managing transportation programs.  Info Tech, Inc., 
developed Trns•port in 1982 to help state highway agencies and attorneys general with highway 
construction bid collusion and anti-trust investigative efforts.  Since then, InfoTech has added 
significant additional capabilities to provide operational and management information support 
for State Departments of Transportation and other construction contract activities.  Activities 
include management-level decision support; project cost estimate and proposal preparation, bid 
letting and award management, and construction contract management.  In October 1985, 
AASHTO purchased Trns•port for licensing to all member agencies to share in the continued 
development and use of Trns•port software.  Of the nine Trns•port and Trns•port related software 
modules, the Department is using seven.  Their relationships are shown in Figure 1 on the next 
page.   

Trns•port BAMS/DSS (Decision Support System) provides a complete historical database of 
construction contract information, a set of analysis models, and the capability for ad hoc query 
and analysis.  The BAMS/DSS module provides a fully integrated management decision support 
system for highway agencies.  The Trns•port BAMS/DSS applications include executive 
information requests, summary reports for management, bid management and monitoring 
analyses, market analyses and cost indices, project planning, project cost estimation, and 
legislative presentation. 

Trns•port CES (Cost Estimation System) provides Department estimators the means by which 
to produce various types of Job estimates such as parametric, cost-based, and bid-based 
estimates.  Predefined and ad hoc formulas can be incorporated in the estimating process, and 
users can assign funding and program information to CES Jobs.  The Trns•port CES module 
works in combination with the BAMS/DSS module to produce accurate, historically based 
estimates.  It also works in conjunction with the PES module, sending and receiving project and 
proposal data that aids in the production of Job estimates.   

Trns•port PES (Proposal and Estimates System) provides Department design, contract 
administration, and estimating staff with a computerized tool to help with project definitions, 
project cost estimation, contract proposal creation, and bid letting packaging.  The detail cost 
estimate for the Plans, Specifications, and Estimate package (PS&E) and bidding proposal are 
two key outputs of the PES module.  

Trns•port LAS (Letting and Award System) provides bid letting personnel with automated tools 
to manage the plan and proposal holders lists, bid data entry, bid tabulation, low-bid analysis, 
and contract award processing.   

Trns•port Expedite (Electronic Bidding System) is designed to work with the PES and LAS 
modules to streamline the bidding process.  The Department uses information form PES to create 
and distribute electronic proposal or amendment files to prospective bidders.  Bidders then input 
and submit their item bids in a secure, machine-readable format.  The Department checks the 
electronic bids for validity and data errors and then produces a file suitable for loading into LAS. 
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Bid Express is used in conjunction with Trns•port Expedite.  Expedite software is used in bid 
preparation.  Expedite is used to electronically prepare and check bids; then submit them over the 
Internet using Expedite to connect to Bid Express.  Bid Express is a storage site that holds the 
bids until the bid date, when it is transferred to the Department.  

Trns•port SiteManager is a comprehensive construction management system that encompasses 
the complete construction management process, from contract award through finalization.  
SiteManager accommodates all levels of construction personnel supporting activities such as 
construction administration, field record keeping, contract record maintenance, contractor 
payment processing, materials management, and civil rights monitoring. 
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Assistance 

For assistance with Trns•port modules use the process shown below.  If you need functional 
assistance contact your supervisors, District Application Coordinators, Central Office 
Application Coordinators, or the Trns•port Coordinator.  For technical assistance begin with your 
district help desk. 
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Entity Relationships 

Trns•port software can be tailored to the Department’s needs.  To efficiently install and support 
the software in varied environments, Trns•port has modular design concepts and programming 
tools that operate with the least amount of modification. 

Trns•port manages data through a series of header records that link to one another.  There are 
three controlling entities in the PES and LAS modules of Trns•port.  These are headers called 
Project, Proposal, and Letting.  Figure 2 illustrates that a Letting Header may have one or more 
Proposal Headers attached to it, and a Proposal Header may have one or more Project Headers, 
as well as addenda, attached.  The figure also shows that within a project, categories are the first 
order detail to a project, and Items are subordinate to categories.  Keep these relationships in 
mind when using PES. 

 

Letting-01 

Proposal-A Proposal-B, etc. 

Project 01 Project 02, etc. 

Addendum 001, etc. 

Category A Category B, etc. 

Pay Items Pay Items 

Figure 2 
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Common Windows Terms and Navigation Methods 

Menu Bar – the Menu Bar contains a list of options.  For example, click on File and the list of 
options include Save, Save As, Print, Open, Close, etc. 

Tool Bar - the Tool Bar contains icons that invoke tools that are specific to the window that is 
currently active.   

Tool Bar - the Tool Bar contains icons that invoke tools that are specific to the window that is 
currently active.   

This icon will produce the Project List Window. 

This icon will produce the Proposal List Window. 

This icon will produce the Lettings List Window. 

This icon will produce the Vendor List Window. 

Select (from a menu, tool bar, or list window), means to move the cursor to the option to be 
highlighted and click the left mouse button once.  If the option has an arrow to the right of it, 
another selection menu will automatically appear.  Click the choice. 

In this manual, notations such as File > Reference Tables > Item List indicate the order of 
selections from the Menu Bar or the Right Mouse Button Menu. 

Click Refers to clicking once with the left mouse button.   

Project List Window 

Menu Bar 
Tool Bar 

Click X to close 
the Window 

Menu from Right 
Click 

Minimize and 
Maximize Window 

Selected Record 
using Left Click 
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Rclick    (right click) - Refers to clicking once with the right mouse button.  The action will open 
a menu. 

DblClick (double click) - Refers to clicking twice in quick succession with the left mouse 
button. 

Close (the X in the upper right hand corner of a window) – To close a window, click the X that is 
in the upper right hand corner of the window.  If you have been editing what is in the window, 
you will usually be prompted to either save or close without saving.  Choose appropriately.  If 
you choose not to save, all of the changes will be lost. 

Minimize (the minus sign in the upper right hand corner of the window) – When this icon is 
clicked, the window will be minimized and deactivated.  It will appear at the bottom of the 
screen.  Re-activate the window by clicking on the minimized icon on the bottom of the screen. 

Maximize (the icon with a square in it on the upper right hand corner of the window)  - This icon 
also minimizes and maximizes, but it does not de-activate the window, it merely changes the size 
of the window.   

Check Box – A box that represents a Boolean value (on or off, yes or no).  If an X or a check is 
in the box, then the value is On or Yes.  If there is nothing in the box the value is Off or No. 

List Box – A drop down box that presents the valid values for a field.  The choices presented 
usually are from a code table stored within the system.  Click an arrow to view the list of 
choices, and choose a value from the list. 

 

Common Trns•port Terms and Definitions 

Batch - A term that refers to a process being submitted and executed in the background without 
intervention by the user.  Reports are an example of processes that execute in batch mode.  This 
also means that a process goes into a queue along with other processes and therefore may have to 
wait its turn to run so the results may not be immediately available. 

Bidder - A vendor who bids on a proposal 

Category – A grouping of items on a project.  For maintenance projects, these would be the task 
activity numbers.   

Contractor - Any entity that does business with the Department.  This is synonymous with the 
term vendor. 

Control Group – The assigning of control groups controls who can see which projects and 
proposals in PES and LAS.  A control group can be assigned three places.  These are users, 
projects, and proposals.  Please see Appendix B to this manual. 

Drill-Down Menus - This term refers to menus that appear when a right click is done on a 
selected record.  As the term implies, every time a right click and select is done, a lower level 
menu or screen appears. 

Estimate - A cost estimate for a project.  PES can produce three different ones.  They are the 
Preliminary Detailed Estimate, the Proposal Estimate, and the Final Detailed Estimate.   

Filter - A function provided in Trns•port   to help limit the list of records appearing on the 
screen. 
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Generic Fields - In Trns•port this refers to fields that are not used within the core Trns•port 
software for any processing, but which are available for the user to enter data into and then use in 
reporting.  Should the user wish to customize the Trns•port software, these fields would be 
available to them. 

Item - The smallest unit of work on a project.  It is the same as the Department’s term Pay Item. 

Item List (item Reference Table) – This is synonymous with the Department's Master Pay item 
List or File and contains all of the items that are open for use in each item year. 

PES Worksheet – This is a screen provided in spreadsheet format that allows for the entry and 
maintenance of items for a project.   

Planholder – This is a vendor that has received a proposal package.  The planholder can be valid 
for bidding or not. 

Procedurally Required Fields – These fields are deemed very important by the Department and 
therefore should be entered even though the system will not force them to be entered.  An 
example of this is the Control Group field (this field controls who is allowed to view the record 
in question). 

Project - This is synonymous with the Department’s financial project. 

Proposal - A grouping of one or more projects that is advertised for contract. 

Site – A proposal site is an entity which can represent different locations or portions of a project 
to which time can be assigned.  There must be a site 00 record for each project.  This will contain 
the time allowed for the entire project. 

System Required Fields – These are fields that are required by the Trns•port software.  They 
must always be entered. 

Tabbed Folders -This refers to a screen where associated records that belong to a key record are 
presented in a folder like form.  A tabbed folder screen looks much like a filing cabinet with 
different file folders.  Each tab presents records in a spreadsheet form.  Many of the same types 
of records may be edited at the same time.  All associated records are saved when the tabbed 
folder screen is closed.  For example, the tabbed folder for a project has a tab for general project 
information, a tab for categories belonging to that project, a tab for funding for the project, etc. 

See Appendix A for a more complete listing of a glossary of terms used in Trns•port.   

 
Document Availability. 

This and other Trns•port documents are available at the following URL: 

http://www.dot.state.fl.us/construction/trnsport/Maint%20Sm%20Users/trng_manual/Main%20
Menu.pdf  

Or you may access them from the Trns•port web site.  

• Click User Guides. 

• Click Trns•port Document Menu.  
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Getting Started 

Logon to Citrix MetaFrame 

Trns•port is supported through the Citrix Secure Gateway.  The applications execute on a Citrix 
MetaFrame server.   

Access to the Citrix MetaFrame server is via the Internet when away from the Department, or the 
Intranet when accessing it from within the Department.  Either way, access will then be through 
the Citrix MetaFrame XP Website. 

Prior to attempting a log in, the Application Security Coordinator will have assigned a UserId 
and password for access to the proper Citrix MetaFrame Group. 

 

From your browser, enter: 
 
https://fdotnfuse.dot.state.fl.us/Citrix/MetaFrame/default/default.aspx 

 

The Citrix Login screen will 
open.   

For quick access to Citrix, 
create a shortcut for the 
desktop.  From the Login 
screen,  

• Rclick to open the 
Mouse Button Menu. 

• Click Create Shortcut 
as seen below. 

 

 

 

This message box 
will appear.   

 

 

 

• Click OK, and this icon will be on 
the desktop. 
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At the Login screen,  

• Enter UserId,  

• Password, and 

• Domain.   

 

Remember that passwords expire every 65 days. 

 

The first time you log in, and as Citrix software is upgraded, you will receive a prompt to install 
Citrix software.  Respond yes and follow the installation prompts. 

 

Logon to Trns•port 

At the Citrix Application 
Portal, see the Trns•port 
Applications available.   

The screen at right shows the 
applications available to a 
typical user.   

To gain access to other 
Trns•port applications, see the 
Application Security 
Coordinator 

 

 

Set up Citrix Printers 

• Click the Printer 
Configuration Icon to 
set up the regular 
printers to work with 
Citrix MetaFrame.   

 

 

• Click each printer 
needed, so that the status shows as "connected".   
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Logon to PES 

The Security Coordinator will have established the system access and security authority.  From 
time to time, for training or other testing events, you may be granted access to the test 
environment.  At those times, the Trns•port Coordinator or the Office of Information Systems 
(OIS) staff will control the security and access.  In general, you will only have access to the 
production environment.   

 

• Click the PES Icon to open PES. 

The screen at left will 
appear.   

• Enter User ID. 

• Tab to and 
enter the 
Password. 

• Click OK, as 
seen at right. 

 

A blank Trns•port PES screen will appear.  To 
access the Project List window,  

• Click the Project icon. 

To access the Proposal List window,  

• Click the Proposal icon. 

 

Field Help 

As you enter data, and have questions 
about a particular field, the field help may 
be very useful.  To access the field help in 
Trns•port PES,  

• Rclick in the field of interest to 
open the Mouse Button Menu. 

• Click Field Help. 

Or 

• Press the H key on the keyboard to 
display field information. 
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An information screen similar to the one seen 
here will appear. 

 

 

 

 

Changing passwords 

When accessing PES the first time, change the 
temporary password assigned by the Security 
Coordinator.   

To change the password, 

• Click Utilities > Change Password from 
the Menu Bar 

The Change Password window will appear.   

• Enter the User Id. 

• Enter the current password in the Old 
Password field.   

• Tab to the New Password field and type a new 
password.   

It must be at least six characters and no more than 
thirteen.  Use a combination of letters and numbers.   

• Tab to the Re-enter Password field and retype 
the new password. 

• Click OK to save this password.   

Change passwords in accordance with Department policy. 

 

Data Security 

To protect the integrity of Trns•port data, take general precautions to safeguard data both from 
unauthorized access, as well as accidental loss. 

PES does not have a time-out feature, whereby the software and hence access to the data are 
automatically locked.  When leaving the PC for an extended period do a normal close of all open 
windows and close PES.  In this way, unauthorized access is not possible. 

Data protection during a power outage is also a concern.  When using tabbed folder windows in 
PES, there is a risk of having a project or proposal become “locked” if there is a power loss.  In 
this situation, the database retains information to the effect that you had a project open, and will 
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continue to deny access to users who may need to make changes to the project or proposal.  To 
safe guard against this, avoid keeping multiple tabbed folders open for extended periods. 

A Windows General Protection Fault (GPF) error will result in the same effect on folders as a 
power loss.  Any opened tabbed folders will remain locked until those folders are reopened on 
the same PC that was involved in the GPF incident or the power loss. 

 

Security 

In PES, each UserId is assigned one or more roles that have a set of functions (called security 
tokens) assigned to them.  These roles are assigned users by District or Central Office Security 
Administrators and control what the user may do in the system.  In addition, each user is 
assigned a control group that controls which projects and proposals the user is allowed to see.  
Each project and proposal in the system is also assigned a control group so the user will be 
presented only with projects or proposal that “match” his personal control group.  A project can 
be “passed” from one user to another by changing the control group. 

 

Example Control Groups 

Type of User   Control Group   

 
District Estimator  ?D03*   ? is a positional wildcard. 
Production Designer  CD03R312  * is a wildcard for all remaining positions. 
Maintenance Designer MD03 Y302    
Consultant   CD??T123 
District Contracts Office ?L03*    
 
Project   Control Group   Users who can see Project 
A   CD03    District Estimator 
B   CD03Z123   District Estimator, Consultant 
C   CD03R312   District Estimator, Prod Designer 
D   CL03    District Contracts 
E   MD03    District Estimator, Maintenance Proj Mgr 
F   ML03    District Contracts 
G   MD03Y302   District Estimator, Maintenance Designer 
 
Confidentiality 

In PES, the estimated price for an item appears on the same screens as the item number and its 
quantity.  This results in some conflicts over the issue of confidentiality.  Whoever can see the 
project can also see the estimate.  There is currently no way to separate the estimated prices from 
the items and quantities.  If the prices need to be kept confidential, then the control group that is 
assigned to that proposal and project must remain in the Estimators control group.  If the 
estimated prices are not confidential at the time, the control group can be set to the Designers 
control group. 
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The proposal and project can be passed back and forth as necessary until the prices do become 
confidential. 

Once the proposal has been advertised the Control Group on the project MUST be left as the 
Contract Administrators control group unless an addendum needs to be processed.  Otherwise, an 
Estimator could change the proposal and project detail and the change would not be reflected in 
LAS.  Any changes that need to be made after advertisement must be made through the 
Addendum process. 

It will be up to each District Office to establish procedures with regard to who has what control 
groups and when the projects and proposals need to be passed back and forth. 

 

Code and Reference Tables 

Code tables and reference tables exist to provide valid values for information stored about 
projects and proposals.  A code table generally consists of only two elements, a code value, and a 
code description.  Reference tables include more information than just the code value and the 
description.  When a code table supports a field on a record, a list box will appear on the screen 
that allows the user to choose from the list of valid values.  List boxes may be accessed by 
Clicking on the down arrow like this one,       or like this one.       

To see the code tables and reference tables in Trns•port, from the Menu Bar  

• Click File > Reference Tables as seen at 
right. 

The next window shows a choice of Code Table 
Lists and several reference tables. 

The Trns•port Coordinator or OIS will maintain 
code and reference tables, except for the Item List.  
Users can view all of the Code Tables and the item 
List.   

To see the Item List reference table in Trns•port, 
from the Menu Bar 

• Click File > Reference Tables > Item List. 

The selection Item List is an example of a reference 
table.  This table is synonymous with the Master Pay 
Item List.  It contains all of the valid items for each 
Spec Year.   

Authorized persons in the Central Estimates Office 
and Central Maintenance Office maintain this Item 
List table.   
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The Item List Reference Table 
You will see that the left column is the 
Spec Year.  As this document is 
published, the active Spec Year is 04.  
Spec Year 07 is being created now and 
the two lists will coexist for several 
months in this table.  Note this example of 
items for different Spec Years. 

 

To view details of a particular item,  

• DblClick the Item. 

Each item has a long and a short 
description.  The long description can be 
up to 60 characters and will appear on all 
reports unless the reports are otherwise 
modified.  The short description is a 
maximum of 40 characters and will 
appear on any screen that shows item 
description. 

An item can be marked as obsolete by 
checking the Obsolete Item box.  Note 
that there is a field called "Item Obsolete 
as of", but it is not actively linked to 
project records.  If an item has been added 
to a project prior to becoming obsolete 
and the project is still active and requires 
a change, when the Obsolete Item Flag is 
set, the item will kick out as an error 
when project changes are saved. 

The Combine with Like Items Check Box 
contains the default value that the item 
will have in this field when it is added to a 
project. 

The Item Class Function field contains a code that categorizes the item into various groupings 
such as utilities, landscape, etc.  This field is very useful in narrowing down the list of items to 
be viewed by use of a filter.   

 

The Trns•port Filter 

A filter provides the user with a means to limit the list of records appearing in a window.  The 
Filter Function is available on most PES screens.  It is especially helpful in limiting the item List.  
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Use the filter to enter selection criteria on one or more fields applicable to the active window.  
For example, you may only want to see items in a particular Pay Item Year, or you may want to 
see Projects with a certain Control Group.  The fields that are available to include in the selection 
criteria will depend on the active window. 

PES and LAS are set up to support both upper and lower case characters.  Fields that are 
populated from the Department mainframe will be in uppercase because the mainframe stores 
everything in uppercase.  For instance, the Item Description is in uppercase, so when filtering on 
the Short Description field, look for all uppercase characters.  All code values are stored in 
uppercase.  When filtering on a code-based field, search for uppercase letters.  Other fields, such 
as the second line of the Location field on the Project Header record, can have both upper and 
lower case letters in them.  Be aware of the case of a field when performing a filter. 

To set up a filter from the Tool Bar,  

• Click the Filter        icon. 

The list box labeled Column will list all of 
the fields that are available for the search.  
The Operator list box contains the relationships that are available between the field that chosen 
in the Column list box and the entry in the Value box.  The Value contains a literal that is being 
compared to the field in the Column box.  In the example above, a simple filter on the field Item 
Number is looking for items that contain the string 0430.   

For more complex filters, such as ones on multiple fields,  

• Click the Advanced button. 

The Advanced Filter feature allows filtering on more than one field and allows you to save the 
filter so that it can be used repeatedly. 

The Name field contains the name of the filter and allows you to choose from a list of previously 
saved filters. 

The Column, Operator, and Value fields operate the same as they did in the simple filter.   
The (+,  )-,  and And/Or columns allow parenthesis to create complex logic.   

To add the first row: 

• Choose values for the Column, Operator, and Value fields. 

• Click the Accept button.   

 

To add another row,  

• Click the Add Row button,  

• Click the row just added.   

• Enter values in the Column, Operator, and Values fields. 

• Click the Accept button. 
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In this example, the filter shows drainage items (Item Class 06) that will become obsolete after 
December 01, 2003.   

• Add parenthesis as needed and 
choose either And or Or as 
appropriate. 

To save the filter, 

• Enter a name in the Name field. 

• Click the Save button.  

The filter will be available for future use.   

To apply the filter now,  

• Click the Apply button. 

 

Code Tables 

The Structure Work Class field is an 
example.  It is supported by the 
FEDWTYP code table. 

To view the FEDWTYP code table, from 
the Menu Bar 

• Click File > Reference Tables > 

Code Table List. 

The Code Table List window showing all 
code tables for PES/LAS will open. 

To see the codes for a particular code 
table,  

• Click the table of interest then 
with the cursor on the blue band,  

• Rclick to open the Mouse Button 
Menu.  

• Click Code Table Entries.   
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Figure 3 

Project Header 

Categories

Items 

Funds 

Counties 

Proposal Header 

Sites 

Long 
Description Special 

Provisions 

Addenda 

This will show a list of all of the entries 
for that code table.  The Trns•port 
Coordinator will maintain reference tables 
and code tables.   

Note that structure classifications are 
listed for this particular table.  All 
structure categories are identified by the 
appropriate code in the Structure Work 
Class field of the Category tab of the 
project. 

 

PES Components 

In PES there are two main components - Projects and Proposals.  These two objects are referred 
to as “root level” objects.  They can exist by themselves.  All other data in PES, except for code 
and reference tables, belongs to either a project or a proposal.  Figure 3 shows some of these 
relationships. 

All work in PES begins with the creation of a project.  As illustrated in Figure 2 on page 7, a 
project is composed of a Project Header record; one or more Category records and each category 
can have one or more items belonging to it.  Figure 4 on the next two pages shows a typical 
project development life cycle in PES. 

There are several ways for a project to be created in PES: 

• A project can be loaded from the FM (Financial Management) system.   

• A project header can be entered by hand.   

• A project header can be created by copying from another project.   
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• A project header can be created by importing it from a source outside of PES.   

 

Currently the Department does not have a procedure or standards in place for the loading of 
projects from outside sources. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Load historical unit prices and/ or 
update estimated unit prices by hand

Generate Project Line Numbers 

Run a Preliminary Detail Estimate 

Run PES Clist to refresh the Project Header Data (if a Copy 
Special was Performed), Enter additional Project Header detail 

Create/Update Category Records. 

Add Items to the appropriate Category, update item 
fields, and delete Items as needed.

Update Control Group on Project Header 
to transfer control of project to Estimates

Run the PES Clist or Perform a Copy Special to 
Establish the Project Header 

Figure 4 
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Create 
Addenda as 
needed 

Change Control Group on Proposal to 
enable Contract Administration to access. 

Generate Bid-based Prices for Proposal and/or 
Update estimated prices based on roll-up quantities 

When satisfied with estimated quantities, generate final 
Proposal Schedule without Proposal Estimate and pass to 
Contract Administration 

Generate a Preliminary Detail 
Estimate for the Proposal

Generate Proposal Section 
and Line Numbers 

Create Proposal Record 

Attach Projects to the Proposal 
(string projects)

Generate Proposal Schedule Report; 
Including Proposal Estimate 
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Maintaining Records in PES 

There are two methods of maintaining records in Trns•port.  These are the tabbed folder method, 
and the drill-down method.  The long-term plan of AASHTO is that the drill-down method will 
be phased out. 

 

The Tabbed Folder Method 

A tabbed folder presents many associated 
records broken out and grouped under 
various Tabs.  Each tab represents a 
different type of record, but all of the 
records in the Folder relate to each other.  
For example in the Project Tabbed Folder, 
see the category records that belong to 
that particular project grouped under the 
Categories Tab.  All of the item records 
that belong to those Categories are found 
under the Worksheet tab, etc.  Using the 
Tabbed folder allows you to view and 
modify many records at once. 

 

The Drill-Down Method 

The second method of maintaining 
records in PES is the Drill-Down method.  
This method involves selecting one record 
at a time and then right clicking on that 
record to “drill down” to the next level.  
For example, to get to a particular item on 
a Project using the Drill-Down method,   

• Highlight the Project, 

• Rclick to open the Mouse Button 
Menu.  

• Click Category List,  
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• Highlight a category. 

• Rclick to open the Mouse Button 
Menu.  

• Click Item List  

 

 

 

 

• Highlight the Item of interest. 

• Rclick to open the Mouse Button 
Menu.  

• Click the Item desired. 

 

 

 

 

 

• Click the Change Button to make 
changes 

• Click the Close Button when 
complete. 
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Creating Projects 

Adding projects into Trns•port PES should be thought of as involving two steps.  The first is to 
create a project header, and the second is to add the project detail. 

In general, projects can be brought into Trns•port PES in one of the following ways: 

• Create a project header through an interface program. 

• Enter a project manually through the Add or Tabbed Folder Add window from the right 
mouse button. 

• Enter a project manually through the Edit > Add or Edit > Tabbed Folder Add window 
from the Menu Bar. 

• Copy detail from one project to another. 

To create a new project, use the FM Interface to create the project header and then add project 
details into the new project, or enter a few fields of data to create a project header and then 
complete information from the FM Interface. 

 

Project List window 

To view the list of projects, from the 
Menu Bar  

• Click File > Open Project List 

Remember that one of the fields on the 
project header is the Control Group.  FM 
populates this field.  If you download a 
project that is not a part of the control 
group, you will not be able to see it on the 
project list. 

 

Another method of invoking the Project 
List window is to 

• Click the Project 
icon on the Tool Bar.   

When the mouse is over an icon on the 
Tool Bar, an information box will appear 
that will identify the icon by name. 
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These methods also apply to viewing other List Windows in Trns•port.  There are four main List 
Windows in Trns•port that the Department uses.  These are  

• Projects 

• Proposals 

• Lettings 

• Vendors 

The Department is not using the Prime Project function. 

 

The FM Interface 

The FM Interface creates and refreshes Work Program information in Trns•port PES.  The 
refresh feature of the interface runs every night and updates fields in all projects in PES 
possessing valid FinProj Numbers.  If a project in the FM system lacks a projected letting 
date, it may not load as a “new" load.  To avoid this problem, enter minimal data in PES for 
the new project and then run TSO.  The refresh feature will complete the projected detail.  See 
Creating a Project from Scratch. 

To execute the FM Interface on 
the mainframe, 

• Enter TSO,  

• Get to a READY 
prompt  

• Type TSM  

• Press <Enter>. 

 

At the Trns•port Interface 
screen,  

• Enter B to either add a 
project, or refresh a 
project, 

• Press <Enter>. 
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At the Add/Refresh Transport 
Projects screen, enter as many 
financial projects as needed.   

• Enter one FinProj 
number per line 

• For the first line, enter 
A (for SEL) 

• Enter 01 (for CARD ID) 

• Enter all 11 digits of the 
FinProj Number 

• Press <Enter> 

To add another project 

• Enter A (for SEL) 

• Enter 02 (for CARD ID) 

• Enter all 11 digits of the FinProj Number 

• Press <Enter> 

If you make an error in the length, an error message will be displayed.  However, there is no 
validation of the accuracy or existence of the FinProj number in the FM system as data is 
entered. 

When you have completed entering projects,  

• Press <Enter> again without entering any data on the row 

At the Job Card Information 
Screen, you will be prompted 
to enter a printer ID, a name, 
and phone number.  When that 
is complete,  

• Type SUB on the 
command line 

• Press <Enter> 
A batch job is submitted that 
will load the selected projects 
into PES.  The job name and 
number appear on the screen to 
the left. 
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Check on the progress of the 
job in IOF.  The job output will 
be put into the IOF queue. 

 

In IOF, view the output of the 
job to see if it processed 
successfully.  Determine the 
sequential number of the job.  
Then enter that number on the 
command line.  This shows a 
list of output sections.   

 

 

Look for the one that is labeled 
REPORT and select it by 
putting an S next to it, or by 
entering the sequential number 
of the REPORT output.  You 
may have to press the F8 key to 
page down to see the REPORT 
output. 

 

 

 

 

If nothing appears in the 
REPORT output, look at the 
output labeled ERRORRPT.  
For example if the FinProj 
entered does not belong to your 
district, this message in the 
output labeled ERRORRPT. 

At the Disposition of Log Data 
Set screen  

• Choose a process 
• Press <Enter> 
• To exit press F3 
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To exit the FM Interface  

• Type an X at the 
command prompt 

• Press <Enter> 

 

A TSO screen will reappear 
with a ready prompt.   

• To exit, type logoff 
• Press <Enter> 

 

 

When the FM Interface completes, the projects will appear in the Projects List window.  (If your 
Projects List window is open, you will have to refresh it by closing it and reopening it before 
your new project(s) will appear.)  If the interface ran with no pre-existing data in PES, these new 
projects will contain an Access Control Group that is accessible to your district.  If it ran as an 
update, the control group you entered will not be changed. 

 

Creating a Project from Scratch 

If you are creating a “real” project from 
scratch, use a proper FinProj number.  
Leave the FM supplied fields blank and 
then run the FM Interface to refresh these 
fields later.  Enter the procedurally 
required fields for the Project Header. 

To add a project header manually,  

• Rclick to open the Mouse Button 
Menu from anywhere in the  
Project List window 

• Click Tabbed Folder Add 

Or 

• From the Menu Bar, Click Edit > Tabbed Folder Add 
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This will display an empty Project Tabbed 
Folder.  Enter the general tab information first 
and then proceed to the other tabs.   

Most fields are blank, but some are defaulted 
to particular values, such as the Unit System 
field (default is English).  Most field defaults 
may be changed as appropriate.   

Proceed to enter data in page 1 of the general 
tab for the following fields: 

Project Number                Enter the Financial Project (FINPROJ) Number. 

Spec Year                          A default value of 04 has been set.  If it is necessary to change it, 
pick the appropriate year from the list window. 

Fed/State Project No.       A default of N/A is assigned.  For Federal Aid projects enter the 
appropriate number. 

Description                        Enter the project description.  It will be updated from the FM 
system. 

Unit System                      The default value is “E” for English.  Change it if necessary. 

Const. Eng.  Pct               The default value is 0.00.  Do not change it. 

District                              Enter the managing district for the project, by clicking on the list 
box and selecting the district. 

Project Work Type            Select from the List box. 

Project Type                      Select from the List box. 

Control Group                  Assign a control group to the project that matches the personal 
control group, except that no wild cards (“*” or “?”) may be used 
in the Project Control Group.  See Appendix B for a discussion of 
the Control Group structure.   

NOTE When adding a project from scratch remember to enter the control group, 
otherwise the project will become “lost” when saved. 

Other fields may be left at their default values.   

• Save the project by clicking the Save       Icon. 

 

Creating a Project Using Copy Special 

Copy Special is a function that provides a quick way of creating Projects or Categories.  It takes 
an existing Project or Category and creates a new Project or Category by copying ALL of the 
records associated with the existing Project or Category.  The new Project or Category can then 
be edited to make the appropriate changes.
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This method will not only create the Project Header, but will also copy all of the other records 
associated with the source project.  All of the records in the Tabbed Folder of the original project 
will be copied to the new project. 

To initiate a Copy Special for a project,  

• Click the source project from the 
Project List window. 

• Click Edit > Copy Special from 
the Menu Bar. 

A window will open that asks you to enter 
the new project number.  The project you 
are copying to cannot pre-exist. 

To perform the copy, 

• Enter the new Project Control Number  

• Click OK.  The new project will be 
created. 

The new Project Control Number should be a 
valid FinProj Number, unless the project being created is a template or temporary project. 

 

Project Data 
Updating Project Headers 

To update an existing Project Header 
record,  

• Rclick on the project to open the 
Mouse Button Menu.  

• Click Tabbed Folder Change. 

 

The General tab 

The General tab contains two pages of Project Header information.  The fields that are 
highlighted are the ones that are populated from FM.   

Project Number   Spec Year  Fed/State Project No. 

Description   Location  Unit System 

Road Number   Status   Road Section Number 

Beginning Termini  District  Ending Termini 

Control Group  Type of Road  Work Mix 

Contract Class  Proposed Letting Date
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These fields (except for Control 
Group) should NEVER be 
updated directly in Trns•port 
because the nightly FM refresh 
process will over write them.  
These fields can be refreshed on 
demand by running the FM 
Interface. 

The Spec Year will default to 04.  Change 
it if necessary.  The FM system will not 
reset this field when the FM refresh 
program runs at night. 

If there is incorrect or incomplete information in any of the FM fields, contact the FM 
Administrator to have the fields updated in FM. 

To view page 2 of the Project Header information,  

• Click the page 2-radio button. 

 Estimated Amt of Project    This 
required field is filled when you 
run the process Generate 
Preliminary Detailed Estimate.  
This process will be run several 
times over the project 
development life.  It must be run 
after the final Engineers Estimate 
for historical purposes.  When the 
contract transfers to SiteManager 
and DSS this field transfers as the 
Engineers Estimate. 

The Type of Road, Work Mix, Contract Class, and Proposed Letting Date fields on page 2 
come from FM.   

To update fields other than those populated by FM, on any screen 

• Type over the field.   

If a code table supports the field, 

• Click in the field. 

• Click the down arrow that appears. 

A list box of selections will appear.   

• Click the desired value in the list box. 
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 If you type something incorrectly in a 
field and wish to restore the original 
value, press <Esc> while you are still in 
the field.  This does not work if you 
selected a value for a field by choosing it 
from a list box.  It only works if you typed 
in a value.  If you need to recover the 
change and have gone beyond the 
particular field, you can close the project 
and NOT SAVE it when the prompt 
comes.  If you do this, you lose all 
changes made in the current session.  This 
is an example of a list box of valid codes appearing for the field Project Type. 

 

The Counties Tab 

To view the Counties,  

• Click the Counties Tab. 

The county record indicates the 
percentage of the project in each county.   

The FM Interface will provide the county 
records and their percentages.   

If you create a project from scratch, add 
county information or leave this tab blank and run the FM Interface to refresh the project. 

If you add a county that does not exist for the project in FM, the refresh process will not delete it, 
however, it will set the Percent of Project Length to zero.  If the county information is incorrect 
or incomplete contact the Work Program Administrator and have them correct the county 
information. 

To add or delete a County record,  

• Rclick to open the Mouse Button Menu. 

• Click Add or Delete as appropriate. 

Remember that information in the County tab is refreshed from Work Program.  If corrections 
need to be made, make them through the Work Program office. 
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The Categories tab 

A Category is a record that belongs to a 
Project.  It is a way of grouping related 
items together.  The tab contains a list of 
all categories included on the project.  
This project has eleven categories 
including Category 0000 for funding. 

A full set of category numbers and titles is 
provided for use in adding pay item detail 
with the initial run of the FM interface. 

When a project will have more than one 
bridge, add categories, so that the number 
of structures categories is equal to the 
number of bridges in the project.  The first 
bridge in a project is assigned to category 
0100.  Additional bridges are assigned to 
category 0101, 0102, 0103, etc.  It is particularly important that the category fields for all 
structures categories be filled as completely as possible.  The detail on the category tabs is the 
source for creating reports to the Federal Highway Administration. 

 

Adding a Category  
To add a category record  

• Rclick anywhere in the top half of the Category tab screen to open 
this Mouse Button Menu.  

• Rclick on a blue band of an existing category and this menu opens 

• Click Add.   

This will open an input window at the bottom of the screen.   

Or  

• Click Edit > Add from the Menu Bar. 

If there are not two sections of the screen showing, 

• Rclick in the screen to open the Mouse Button Menu.  

• Click Show Detail. 
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You should then see both an upper and 
lower section of the screen. 

A new blank line appears in the top half of 
the screen. 

The Category No. field is the unique key 
to the Category record and therefore each 
value must be unique to a particular 
project.   

• Enter the Category Number.   

 

 

 

 

Choose from the following list.  These 
categories align with the Department’s 
standard Design Groups: 

0000 FM PROJECT FUNDING (Required) 0100 STRUCTURES  

0200 ROADWAY     0300 SIGNING 

0400 LIGHTING     0500 SIGNALIZATION 

0550 INTELLIGENT TRANSPORTATION SYSYTEM 

0600 LANDSCAPE/PERIPHERAL  0700 ARCHITECTURE 

0800 UTILITIES     0900 MASS TRANSIT 

 

Categories Tab page 1 
• Complete the following fields for each category: 

Category Description     Enter the description from the above list. 

Proposal Section Number     Leave this blank.  It will be automatically generated later. 

Federal Construction Class     Choose the Design Group from the drop down window.  
This value is from the FEDCCLS code table.   

Combine w/Like Categories     The default value for this flag is YES. 

Construction Eng. Pct     Not in use.  A default value of 0.00 will appear. 

Category Length     Enter miles or kilometers.  Assign the full length of the roadway 
portion of the project in the Roadway Category, and assign the overall bridge length 
to the first structure category.  The combined length will equal to the overall project 
length indicated in the plans. 
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Category Width     The width of this portion of the project in feet or meters. 

Structure Work Class     For structures it is very important to fill this field.  Choose the 
drop down menu the appropriate classification for the structure.  This field is used to 
classify work for pre-qualifying bidders.   

Structure Work Type      Similar to the Structure Work Class, except that the FEDSUPP 
Code Table is used.   

Bridge ID       The Bridge Number.   

Bridge Length (Ft/M)      The length of the particular bridge in feet or meters. 

Bridge Width (Ft/M)     The width of the particular bridge in feet or meters. 

Bridge Type     A value selected from the attached BRDGTYP code table that indicates 
the type of bridge (e.g., Overpass, Trestle Low, etc.). 

Number of Spans     The number of spans of the structure represented by a category.   

 

Categories Tab page 2 
When information on page 1 is 
complete,  

• Click on the page 2 radio 
button to display the remaining 
fields. 
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Certain information contained on the 
general page has been repeated here (e.g., 
termini, stationing, and section number).  
It is not required that all categories reflect 
the same overall information.   

Required Fields  

Beginning and Ending Termini – 
FM supplies these.  Verify their 
accuracy. 

Unit Number     Not in use at this 
time.  The default value is 000.  
Do not change this value. 

 

 

 

If the category is a structure complete the 
following four fields from values in their 
respective drop down boxes. 

Super Structure Type   Substructure Type 

Foundation Type   Structure Location  

• Click OK in the gray area to accept the row of data.   

To enter another category, 

• Click ADD MORE and continue. 

• Click OK when complete.  

• Click CANCEL to return to the Categories List window without saving the new record. 

 

The Combine with Like Category Flag 
(See also Combine with Like Items) 

The Combine with Like Categories field 
and the Combine with Like Items field on 
the Item Record control the presentation 
of items for bidding in the proposal.  
When both of these fields are marked Yes 
(or checked) then items from categories 
which have the same Federal Construction 
Class and the same Category Alternate 
Code will have their quantities combined and only be presented once on the proposal for bidding. 
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For example, if there are two separate categories each of which contained the tem 2515  1  5 
PIPE HANDRAIL and the Combine Flags were both set to Y, then the quantities for these items 
would be combined and the item would appear only once on the proposal.  If the Combine with 
Like Category Flag is set to N then this will override the settings on the Combine with Like 
Items flags and the items for that category would not be combined on the proposal.  If the 
Combine With Like Category flag is set to Y then individual items can be excluded from 
rolling up by setting their flags to N.   

 

Like Category  Like item Result 

 Y   Y  Quantities Combined 

 N   Y  Quantities Not Combined 

Y   N  Quantities except for particular item combined 

 

Creating a Category Using Copy Special 
There is a Copy Special feature for a category similar to the Copy Special for a project.  The 
difference is that only the particular category and its associated records (Item detail) will be 
copied and not the entire project.  Because 
of this, the project that you are copying to 
must already exist but the category you 
are copying to must not exist. 

This function can be used to create the 
Category records for a new project.  Copy 
them from a template job that has all of 
the categories in it or copy individual 
categories from existing jobs that are 
similar to the one being created.  This 
saves a lot of typing by eliminating the 
need to add items by hand.  Once the 
Category is copied, add or delete items 
and update the quantities as appropriate. 

To initiate the Copy Special for a 
category, from within the Category Tab of 
the project,  

• Highlight the category number to be copied. 
• From the Mouse Button Menu, Click Copy Special 

Or 
• From the Menu Bar, Click Edit > Copy Special. 
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A screen will ask for a destination Financial 
Project Number and a destination Category 
Number.  The duplicate category may be created 
in the Project that is open, or it may be created in 
another Project.   

• Enter a Project Number. 

• Enter a Category Number. 

• Click OK when you are finished. 

 

Alternatively, copy a category by drilling 
down to the source project from the 
Project List Window. 

• Rclick the project in the Project 
List window to open the Mouse 
Button Menu.  

• Click Category List. 

Then, 

• Click the Category to copy 

• From the Menu Bar Click Edit > 
Copy Special. 

A screen will ask for a destination 
Financial Project Number and a 
destination Category Number.  You may 
create the duplicate category in the 
Project that is open, or you may create it 
in another Project.  While this screen is 
not identical to the one shown earlier it 
displays the same information. 

• Enter a Project Number. 

• Enter a Category Number. 

• Click OK when you are finished. 
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The Category 0000 Record 
One special category record is created by 
the FM Interface.  This is the Category 
0000 record.  It contains all of the funding 
information for the project.  Trns•port 
permits funding for each category; 
however, The Department has elected to 
store the entire project funding under the 
0000 Category.  The funding information 
will not be updateable in Trns•port and 
Category 0000 should never be deleted.   

If any funding information is in error, 
contact the Work Program staff to have it 
corrected.  Here is an example of the 
Funding Information that came from FM.  
You will not be allowed to update, add, or 
delete any funding information. 

 

 

Updating Category Records 
From the Projects List window, 

• Rclick to open the Mouse Button 
Menu.  . 

• Click Tabbed Folder Change. 

• Click the Categories tab.   

To update a category record, 

• Highlight the Category. 

This will make the category detail 
available at the bottom of the screen.   

• Enter the desired information in 
the fields at the bottom.   

• Click the OK button when 
complete. 

To update the information on Page 2, 
click the page 2 Radio button and change 
the data in a similar manner. 
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The scroll bar at the right in the bottom half of the screen allows you to see additional fields for 
that particular category.  The scroll bar on the right hand side of the upper half of the screen 
allows you to scroll up and down through the category records. 

 

Deleting a Category Record 
There are two ways to delete a category 
record. 

To delete a category record from the 
Category Tab in the Project Tabbed 
Folder, 

• Rclick the record. 

• Click the Delete option on the 
Mouse Button Menu. 

 

Or  

• From the Menu Bar Click Edit > 
Delete. 

• Click the record to be deleted. 

You will be prompted with a window that 
asks to confirm the delete. 

 

 

To continue with the delete,  

• Click the Yes button, otherwise, 
Click the No button.   

If you press the Yes button you will again 
be prompted with a window telling you 
how many records will be deleted and 
what other dependant records will be 
deleted. 

When you delete a category, you will also delete any fund records and any item records that 
belong to that category.  Again, if you do not want to continue with the delete, press the No 
button. 

• Click Yes to delete the category 
record and all of its associated 
records. 
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These same methods of Rclick to use mouse button menus or selecting the option from the Edit 
selection on the Menu Bar are available for most other entities such as Projects, Proposals, Items, 
etc.  You may also select functions such as Add in the same manner. 

 

Saving Data in Tabbed Folders 

To save the changes in the Tabbed Folders, click the X at 
the upper right hand corner of the Tabbed Folder window.  
You will be notified as to which tabs had changes 
recorded for them and you will be prompted to confirm the 
save. 

If you choose No then, you will exit the Tabbed Folder 
window without saving anything, but also without 
changing anything. 

If you choose Cancel, no changes will be posted to the database and you will be returned to the 
Tab that was active when you clicked the X. 

Choosing Yes above will give you this window.  
If you click the Yes button, the data will be 
validated and then the changes will be made to 
the database. 

Do NOT click the Save As button.  This option 
creates a temporary file on the PCs hard drive.  It 
also locks the project that you were working on so 
that no other users can access it.  This is very 
dangerous because if the PC has a failure, the project will be unavailable until the Trns•port 
Coordinator or an OIS person can clear the lock on it.  In addition, any changes that were not 
committed to the database will be lost. 

When you make changes to the Worksheet, all of the records will be verified and updated, 
regardless of whether or not the record was actually changed.   

Always click the X to save while in Tabbed Folder Add.  As with most windows programs, the 
Save icon on the Tool bar or Click File > Save from the Menu Bar are also available 

 

Cautions on Deleting Data 

Trns•port has three levels of delete available in some instances.  Users should in general never 
use Power or Strong delete unless the full effect of the action is understood. 

Delete   The lowest level of deleting.  Usually deletes one data record from one file, and one 
Delete Warning window.   

Power Delete   This second level of deleting, deletes multiple records from more than one file.  
Two Delete Warning windows will appear.  For example, if you are deleting a bid-letting 
package, Power Delete will delete the letting call, bids, planholders, and proposal.   
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Strong Delete   The third level of deleting, deletes multiple records from more than one file and 
three Delete Warning windows will appear.  For example, if you are deleting a bid-letting 
package, Strong Delete will delete the letting call, bids, planholders, the proposal and the 
projects, items and funds (the whole tree of data).   

 

The Funding Tab  

Trns•port carries no specific funding data 
for projects or proposals.  The terms 
“Participating” or “PART” when used in 
Trns•port are to mean that the project or 
the individual pay items participate in the 
funding to be ultimately associated to the 
project. 

There is no information to be completed 
on the funding tab.  All data is created in 
the Financial Management System (FM) 
and populates this tab.  Do not change 
any values on this tab. 

 

The Breakdowns Tab 

A default value of "1" and "Worksheet 
Breakdown Default" should appear 
automatically to satisfy Trns•port system 
requirements.   

This tab is used for construction projects to classify them using the "search 16" process and 
contractor qualifications.   

 

The Worksheet Tab 

Adding Items to Project Categories 
Since the FM system has no Item data, most of the work will be in this Worksheet tab entering 
Items and quantities.   

All items must be associated with a category under a project.  An item is under a particular 
category for several reasons.  First, it fits with that grouping of items.  Assign the items to 
categories as they relate to the MMS activity the category represents. 

There are several ways to add items to a project category.  The first method is using the PES 
Worksheet.  This method is good to use for initially adding many items, however it can be 
overwhelming if you are only updating a few item quantities or adding only a few items.   
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To access the Worksheet 

• Rclick the Project to open the 
Mouse Button Menu 

• Click Tabbed Folder Change.   

• Click the Worksheet tab.   

 

 

Adding and Deleting Rows 
As can be seen, there is only gray space 
where Item information is to reside.  
Begin by entering blank rows to hold the 
Item data.  Create the first row by, 

• Rclick in the gray space. 

• Click Add.  This creates one row. 

 

For additional rows, 

• Rclick in the grid. 

• Click Insert Row to add the 
number of rows you need.   

 

 

 

 

 

 

Begin entering Item data on a row by:  

• Selecting the Category Number to 
which the Item belongs.  Choose 
from the list box at the 
bottom of the screen in 
the Category Number column. 
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Add or delete rows in the Worksheet of an 
existing project by, 

• Rclick in the Worksheet to open 
the Mouse Button Menu.  

• Click the appropriate action.   

• Click Insert Row, and a blank 
row will be inserted prior to the 
highlighted item.   

• Click Add Row to End and a 
blank row will be inserted at the 
end of the Worksheet.   

On a blank screen, the option that will 
show in the Rclick menu will be Add.  
The Insert Row and Add Row to End will 
not appear on the list until other rows are 
there.  Select these options from the Edit 
option on the Menu Bar. 

To quickly add many rows to the end of 
the worksheet, hold down the <Shift> key 
and press the <Insert> key repeatedly. 

• Click Delete, and all of the 
selected (highlighted) rows will be deleted.  There will be a delete confirmation screen. 

The data in any grayed out columns cannot be updated.   

To update a field  

• Click the field. 

• Enter the new data.   

The arrow icon beneath the Item Number column will open the item List from which to choose 
an item.  Keep in mind that this takes a while to load so it is better to just type the Item Number 
in if you know it.  The item description and some of the other grayed out fields will 
automatically be populated from the item Reference table. 

Any fields that are flags must have a value of either “Y” or “N”.  These values MUST be capital 
letters. 
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Items Requiring Special Attention 
There are five items that require special attention with regard to the setting of flags.  These are: 

 Item Number  Description    Pre-Established        Non-Bid 
           Price                Item 

 0999 16   Partnering (Do Not Bid)          Y  N 

 0999 20   Disputes Review Board (Do Not Bid)        Y  N 

 0999 25   Initial Contingency Amount (Do Not Bid)       Y  N 

0999102  1  S&L Enforce Officer (State Furn)CO Cont        N  Y 

0999102  2  S&L Enforce Officer (State Furn)DO Cont         N  Y 
When these Items are used, the flags for them should always be set as indicated here.  A “Yes” 
in the Pre-Established Price field will pre-fill the amount in the Bid blank when it is created.  A 
“Yes” in the Non-Bid Item field will include the cost in all project reports and totals, but it will 
block the creation of a proposal line number which will keep the item from appearing on the Bid 
Blank. 

 

Breakdowns 
Even though the Department is not using 
breakdowns, the Worksheet was designed 
around breakdowns and breakdown items.  
Therefore, several fields are required even 
though they will not be used.  Breakdown 
ID is one of these fields.  The number "1" 
should always be entered for this field.  
The Breakdown Item Line No and the 
Project Item Line No column are also 
required.  These columns each contain 
sequential numbers.  There are automated 
methods of generating these numbers. 

To generate the sequential numbers for the Worksheet 

• Click Edit > Assign Line Numbers from the Menu Bar.   

• Click Project items or Breakdown items as appropriate.   
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Project item Line numbers will be generated in increments of five.  Breakdown Line item 
numbers will be generated in increments of one. 

To set the Breakdown Id of all records, 

• Enter a "1" in the first record and 
tab out of that field. 

• Click on the Column Heading to 
highlight the Breakdown ID 
column. 

• Click Edit > Range Fill > Fill 
Down from the Menu Bar. 

This will populate all of the records with a 
Breakdown Id of “1”. 

The Range Fill option will fill all of the 
records.  Partial range fill is not currently 
supported.   

 

Worksheet Field Definitions 
Breakdown ID     Not used, but required by Trns•port.  If the default value of 0001 does not 

appear, enter a value of 0001.  Use the Edit > Range Fill option to set all occurrences 
to 0001. 

Breakdown Item Comment     Not used. 

Breakdown Item Generic Number 1     Not used. 

Breakdown Item Generic String 1     Not used. 

Breakdown Item Line Number     This is a required field.  It can be entered automatically.  
To assign this number Click Edit > Assign Line Numbers > Breakdown items from 
the Menu Bar. 

Breakdown Item Quantity     Enter the quantity for the Item. 

Category Number      Enter the Category Number from the drop down window.   

Extended Amount     The product of the quantity times the price.  Trns•port automatically 
calculates this field. 

Item Alternate    This is a 3-digit code used to identify alternate items.  Maintenance 
currently does not use alternate items. 

Item Description     System generated when an Item Number is selected. 

Item Number     The pay Item Number from the Master Pay item List.  It is contained in the 
ITEMLIST code table of Trns•port. 

Item Units     The unit of measure for the Item, which is system generated. 
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Pre-Established Price     The default value for this field is "Y".  The Pre-established Price 
Flag field determines whether the Estimated Price of an item will be automatically 
entered on bidders proposal schedules.  If set to “Y” then the item will appear on the bid 
blanks, however the unit price will be filled in and not bid on by the bidder.   

Price Lock Flag     The Price Lock flag field indicates whether manually entered estimate 
price information for any automatic processes will update items.  Enter “Y” in this field 
to restrict modifications to manually entered information, in other words, to “lock” the 
manually entered prices. 

Price Source     The Price Source field identifies the source of the Estimated Unit Price.  The 
entry in the Price Source field must be a value from the PRICSRC code table.   

Project Item Generic Code 1     Not in use. 

Project Item Line Number     The Project item Line Number field is a four digit number 
Trns•port uses to identify the item.  Trns•port will automatically enter this value it runs 
a process.  These numbers may be entered directly in the worksheet by selecting Edit > 
Assign Line Numbers > Project items. 

Non-Bid Item     The default value for this field is "N".  Non-Bid items will not appear in 
any bid documents, and will not be passed to SiteManager.  A common use for this 
field is to identify FHP use on a project where the Department is reimbursing the FHP 
directly and not through the contract. 

Estimated Quantity     Used by Trns•port to determine the extended cost of an item.  It is 
generated from the Breakdown item Quantity and cannot be changed. 

Supplemental Description Part One     Not in use. 

Supplemental Description Part Two     Not in use. 

 

The Attachments Tab 
All of the Trns•port tabbed folder windows have an Attachments tab.  It allows you to integrate 
OLE-compatible documents (for example, letters or spreadsheets), web pages, and plug-in 
applications into Trns•port.  At this time there are no standards established for use of this feature.   

 

Customizing the Worksheet 

You may do some things to customize the look of the Worksheet.  Change the size and location 
of a column or hide columns.  See Appendix C for a more complete discussion on customizing 
the worksheet.  With Citrix MetaFrame, the customizations discussed here will be saved to the 
Citrix Server in use when the changes were saved.  You will have to re-do these settings for each 
server in use. 
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Rearranging Columns in the Worksheet 

To rearrange the order of the columns in the Worksheet, put the cursor on the heading of the 
column to move and hold down the left mouse button while you drag the column to its new 
location.  You may only move the column around on the screen that is currently visible, so you 
may have to drag and drop several times. 

 

Resizing Columns  

To resize a column, place the cursor on the right hand vertical gridline of the column heading to 
resize.  The cursor will change from an arrow to a vertical bar with two arrows on each side.  
Hold the left mouse button down, drag and drop the vertical line to where you want it. 

 

Hiding Columns 

Some Worksheet columns such as the 
Generic fields will not be used.  These can 
be hidden so the Worksheet is smaller.  
This also protects from inadvertently 
entering information in the fields.  This is 
important in the case of the Supplemental 
Description field, because data in this 
field affects how items roll up on the 
proposal.  The Department has made the 
decision NOT to use the Supplemental 
Description field. 

To hide columns,  

• Click Edit > Hide Columns from 
the Menu Bar.   

This will open a screen that shows all of 
the available columns for the Worksheet.   

• Highlight the columns to be 
hidden by clicking on them.   

To re-show a particular column click it to 
un-select it.   

 

 

To show all columns again,  

• Click the Show All button. 

 



Reference Manual for Production Projects & Proposals PES Release 5.9a                                         Page 51 of 133 

Sorting Records in the Worksheet 

To sort the records in the Worksheet, click the 
Sort       icon on the Tool Bar.   

• Choose the columns to sort and their order.   

To add additional fields,  

• Click the Add button.   

• Click the Apply button when complete.   

 

Printing the Worksheet 

To verify what Worksheet data, it is often 
helpful to have a hardcopy report to look 
at.  Get a listing of the Worksheet by 
running a Worksheet Report. 

To do this,  

• Click Edit > Generate 
Worksheet Report > Visible 
Columns from the Menu Bar.   

The Print Worksheet message window 
will open showing the printer to be used.   

If the printer is correct  

• Click OK 

Otherwise 

• Click Printer 

• Select another printer.   

• Click OK 

 

Using the Drill-Down Method  

The Drill-Down method involves 
selecting a particular object and then 
Rclick it to Drill-Down to the next level 
or DblClick to update the associated 
information.  This method deals with one 
Item record at a time within one category 
at a time within one project at a time.   
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Adding Items  

By using the Drill-Down method, you may open a window that shows all of the detail of an 
element in a single display.  For Pay Items, this window is very similar to the one seen at the 
Master Item list.  For Categories, it is similar to the lower window portion of the Categories Tab 
with pages one and two combined. 

To Drill-Down on a project to the 
category level 

• Rclick the project of interest. 

• Click Category List from the 
Mouse Button Menu. 

The list of categories will open. 

• Rclick the category to which to 
add the items. 

• Click Project items List. 
From the Item List window,   

• DblClick the item to update. 

Or 

• Rclick and Click Item or Change.   

To add a new item,  

• Rclick 

• Click Add.   

When you Rclick from the Item List and 
Click Add, you will get a mostly empty 
screen.  Unlike the Worksheet, this screen 
will not refer to Breakdown fields and 
the Item Line Number is automatically 
assigned.  When re-opening the 
Worksheet after adding items through the 
Drill-Down method, the breakdown fields 
will be empty.  Remember to fill them in 
the Worksheet.   
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This is an example of an Add Item 
Screen.   

After entering the Item Number and 
leaving that field, the program will 
automatically enter the description and the 
default for the Combine with Like items 
Flag.   

Note that the Project item Sequence 
Number is assigned automatically.  In the 
Worksheet, you had to generate this 
number.  Spec Year is also pre-filled. 

When you are finished entering the 
information,  

• Click OK to save the record.   

• To keep adding records click the 
Add More button. 

To delete an item  

• Rclick 

• Click Delete. 

To enter changes, first click the Change button if you opened the window with a DblClick.  The 
down arrow after the Item Number field will open the Item.  As in the Worksheet, this takes a 
while so if you know the item numbers it is faster to type them in.  Some fields are backed by a 
code table, and when you click the field, or tab to the field, the arrow will appear allowing 
selection from the table.   

• Click Close to save the changes and exit the screen. 

The key difference between the Worksheet and the Drill-Down methods is that the Worksheet 
processes many records at a time and the Drill-Down method deals with one record at a time.   

 

The Quantities and Prices Window 

The Quantities and Prices window is a screen that allows updating of only the item Quantity and 
the Estimated Price.  You may not add or delete items using this screen.  It is helpful in the case 
where you have copied the items from another project or a template project and you only need to 
change the quantities of the items.  This screen is also accessed via the Drill-Down method. 
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To access this screen, 

• Rclick the Project 

• Rclick the Category List 

• Rclick the desired Category 

• Click Quantities and Prices. 

 

• Enter the quantities or estimated 
prices for the items. 

Use the Sort function here to get the items 
into the order that is best for performing 
the update.   

Hide columns and move columns around 
in the Worksheet.  However, the changes 
are not saved, as they are when 
customizing the Worksheet.  They will 
only be there for the duration of the stay 
in that window. 

 

Combining Projects 

You may want to combine project 
information when different people have 
developed different portions of a project 
that in the whole has extensive category 
and pay item detail.  You could have a 
situation where three people are developing a project in separate parts, such as lighting, or 
signing and marking, or structures, where each one has developed details in these several 
categories. 

• To combine the work, designate one of the projects as the host project.  This would 
usually be the project having the real FINPROJ Number as its Project Control Number. 

• Verify that all of the category numbers to be involved in the ultimate project pre-exist in 
the host project. 

• If you have made any last minute changes to the host project, save it so that the project 
information exists in the database as well as in the memory of the PC.  The database is 
where the process of combining the projects will occur. 
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To combine two or more projects into a 
single project: 

• Click the host project in the 
Projects List window.   

Trns•port will keep the header from this 
project and add categories and pay items 
from other projects to it.   

• Click Tabbed Folder Change to 
open the project.   

• Click the Worksheet tab to open 
the Worksheet for the selected 
project.  

Note that in this case, there are pay items 
displayed, but in another situation, there 
may not be.  A view of the category tab of 
this project would reveal that all 
necessary category numbers exist. 

 

 

 

 

• Click File > Import > Combine 
Projects from the Menu Bar. 

 

 

 

 

 

 

Trns•port displays a list of projects.  Use 
the Filter and Sort options to help locate 
projects to combine.  Only combine projects 
that have the same Pay Item Year and same 
Unit System. 

• Click a Project Number to combine. 



Reference Manual for Production Projects & Proposals PES Release 5.9a                                         Page 56 of 133 

• Click OK.   

Trns•port returns you to the Worksheet 
where it loads data from the selected new 
project into the host project Worksheet 

• To combine other projects with the 
first project, repeat these steps for 
each one. 

• When all projects have been 
combined, rerun the Assign Line 
Numbers process for both Project 
Line Numbers and Breakdown 
Line Numbers. 

 

Generating Reports and Running Processes 

In PES, reports and other batch jobs are run by the Run Process selection.   

 

Project Level Reports  

Using the Mouse Button Menu 
After entering projects, add categories, and items, and designate where the work is being done, 
run project-level reports.  The Preliminary Detail Estimate process produces a printed report that 
details the Items.  Trns•port also summarizes the estimate with subtotals for item categories and 
funds.  

• Click the project for which to 
generate reports in the Projects 
List window.   

(To select more than one project, hold 
down the CTRL key and select additional 
projects with the mouse). 

• Click Run Process from the 
Mouse Button Menu.   

Here is a sample list.  Your security 
authority may not permit you to run all of the processes available. 

 

Generating a Preliminary Detail Estimate 
One of the most useful reports is the Preliminary Detail Estimate.  It may be run at both project 
and proposal levels.  Its value is that it contains all of the structural detail of the project or 
proposal with line numbers, sections, categories, items, and quantities.  Trns•port also 
summarizes the estimate with subtotals in several formats.   
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To run a Preliminary detail Estimate, 

• Click Generate Preliminary Detail Estimate 
from the Processes List window 

• Click OK.   

 

 

Trns•port displays the Detail Cost Estimate 
Parameters window. 

The parameter selection window has three pages.  
Page 1 shows a default selection to renumber the Item 
line numbers.  To renumber them,  

• Click the box to set the check mark. 

• Click the Page 2 tab. 

 

On page 2, enter the level of summarization.  Project 
is the default level.  This option determines whether to 
run the Detail Estimate for a project, prime project, or 
proposal.  The Department is not using prime projects.  
After entering the level of summarization,  

• Click the Page 3 tab. 

 

 

Page 3 shows the Parameters window, which allows 
you to select the reports to produce.   

• Check the boxes of the reports to generate.   

• Click Submit to run the process. 

• Click Parameters to change process 
submission parameters. 

Or  

• Click Cancel to return to the Projects List 
window without running a process. 

• When you click Submit, two informational windows will 
appear.   

The first will inform you that the process has been submitted.  
When they appear, 
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• Click OK.   

When your process is completed, this window 
will appear. 

• Click OK.   

 

Using the Menu Bar 
Select the project or projects for which 
you will run reports.  To do this, click the 
project in the Project List window.  To 
select more than one project, use the 
<Ctrl> key and/or the <Shift> key.   

 

Then,  

• Click File > Run Process from 
the Menu Bar. 

The Processes List will appear.  The 
contents of the Processes List window will vary 
depending upon what object you are running the process 
on (project verses proposal, etc.). 

The List Projects report will generate a report that lists 
project header information for all selected projects. 

Proceed as above when using the Mouse Button Menu 

commands. 

 

Viewing Reports  

To see the results of this process, from the 
Menu bar, 

• Click File > Process Status.   

 

 

This screen lists all of the processes 
recently run. 

• Highlight the report just run 
(check the date and time columns),  

• DblClick the blue band. 
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Usually reports are labeled 
OUTPUT.TXT.  Sometimes there will be 
more than one report available.  For 
example, you may have an exception 
report in addition to the regular report.   

These are the reports available 
from this process. 

• Click the report to be 
opened. 

• DblClick the report 
OUTPUT.TXT and 
review the report on 
screen. 

The Show system files check 
box will show all of the files the 
system generates.  If the process 
gets an error when it is run, you 
may need to look at these files 
when you work with the System Administrator to debug the problem.  Otherwise, leave the box 
unchecked to limit the list of output files displayed. 

The report window has a toolbar associated with it that permits text editing.  You may highlight a 
word or phrase and change the font, use line out, bold etc. 

Scroll through the report by using the scroll bars at the left and at the bottom of the screen. 

When you have determined that you want a copy of the report, 

• Click the Print button at the bottom of the screen. 

The Save As Text and Save As Rich Text buttons allow you to save the report to a file on the 
PC. 

The Done button closes this screen and returns to the output list screen. 

 

Deleting Reports  
Over time, this Process Status List 
window will grow to the point that the 
scroll bar is needed to see all of the 
reports.  Each user will need to delete 
reports that are no longer needed.  To do 
this, 

• Hold down the CTRL key. 
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• Click each process to be deleted.  
In this example three records have 
been highlighted. 

• After highlighting the rows to be 
deleted,  

• Place the cursor on one of the blue 
bands.   

• Rclick to open the Mouse Button 
Menu 

• Click Delete. 

A delete confirmation window will open.   

• Click YES TO ALL 

The Process Status List window will appear.  
It will be necessary to routinely delete 
unneeded process files. 

 

Printing Reports 
To print the report,  

• Click the Print button 

A window will open showing the default 
printer you set up for Citrix.   

• Click Print again and your report will go to 
the designated printer. 

If your report is printing in Portrait, click the Printer 
Setup button, and at the layout tab, change the layout 
to landscape. 

 

NOTE: If you have not previously done so, you will need to configure Citrix MetaFrame 
to print your reports.  Follow the procedures in Appendix D. 
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Creating Proposals 

A Proposal in PES is one or more projects that are going to be let as one contract.  A Proposal 
becomes a Contract once it is awarded.  In a Project, you had Category and Project Line Item 
Numbers.  In a Proposal, you will have Sections and Proposal Line Numbers that serve a similar 
function in managing the proposal.  In a project, the Combine Like Items flag determine which 
items are combined for bidding purposes.  The Combine with Like Categories flag controls how 
categories are presented to the Bidders on the Proposal.  If Categories and items are set to 
combine, then the quantities will be added together and presented only once on the Proposal for 
bidding.  Sections are created from Categories.  The example below illustrates what happens in a 
Proposal when two Projects are “strung” together under the same Proposal. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this example, the Categories in both Projects are set to combine, with an X in the Combine 
w/Like Categories box.  All of the items in each Category are marked to Combine with Y in the 
Combine flag column on the worksheet.   

In some views, flags may be set with a check mark (√), while in other views they may be set with 
an x.  In either case, these marks are converted to Y when the data is saved and transferred to the 
database.  If a box has a "blank in it, it is transferred to the data base as an N.   

The Proposal automatically rolled up all of the item quantities in the Categories for both Projects 
and put them in Section 0001.  Each item will appear in Section 0001 only once. 

If any category had been marked as Combine = N, then another Section would be created.  If any 
item had been marked as Combine = N, then that item would appear twice (or more) under the 
combined Section 0001. 

Section 0001 

Proposal 

Project B 

0101 
Structures 

0200 
Roadway 

0101 
Structures 

0200 
Roadway 

Project A 
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Like a Project, a Proposal has a Control Group assigned to it to control who can see which 
Proposals.  When you create a Proposal, it defaults to your personal Control Group.  
Change this immediately if you have an "*" or "?" in your group.  It must be changed prior to 
adding a project to the proposal.  Save the Proposal after you fill in the Proposal General Tab and 
then reopen the proposal to add the rest of the Proposal information and attach Projects.   

To access the Proposal List window,  

• Click the Proposal        icon. 

 

 

 

To add a new Proposal, 

• Rclick in the Proposal List 
window and  

• Select Tabbed Folder Add. 

 

 

 

 

 

 

 

Lump Sum Contracts 

For projects that are to be let as Lump Sum contracts, dummy projects and proposals will be 
created to track project and proposal detail.  These tracking projects will be set up one for one for 
the proposal and all projects attached to it.  Tracking Projects will be identified by an eleven 
character ID.  The first nine will be the first nine characters of the Financial Project Number 
plus the two characters LS.  These tracking projects will be fully defined with pay items, 
quantities, prices and all other details of a regularly let project. 

The Tracking Proposal IDs will be seven characters in length.  The first five will be the regular 
Contact ID plus the characters LS.  A representative contract number would be T3052LS or 
E2G53LS.  After the regular projects and proposals are created and synchronized with the 
Financial Management System (FM), the tracking projects and their proposal header may be 
created with the copy special feature. 
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Proposal Data 
The General Tab 

General Tab Page 1 
This is the blank Tabbed Folder for a new 
Proposal.  Notice the similarity to the 
Project Tabbed Folder; there is a General 
Tab with two pages of information and 
other tabs that contain other groups of 
records that pertain to the Proposal.  The 
Department is not using the Special 
Provisions, FY Schedule, or Attachments 
Tabs at this time. 

Page 1 of the General tab has the following fields: 

Contract ID        A unique identifier for a proposal or contract.  Enter the planned District 
Contract number, and use it as a Proposal Identifier.   

District Let Contracts:   Enter the planned District Contract number in the 
general form E#???, where # is District Number and ??? is a sequence 
number.  Do not enter dashes or spaces.  If a contract is to be renewable, add 
the suffix –R0 to the contract ID. 

Central Office Let Contracts:    Enter the planned "T" number in the 
general form T#???, where # is District Number and ??? is a sequence 
number.  Do not enter dashes or spaces. 

Letting Number     A unique identifying number or alphanumeric for a letting.  It may be 
composed of any combination of eight numbers and letters.  For lettings in the districts, 
allocate two positions for the district number, two for the year, two for the month, and 
two for the date.  This will be in the form of ##YYMMDD, where ## represents the 
district number.  If the occasion should arise that you will hold a second letting on the 
same date, you may insert a "B" in position seven.  The Central Office lettings 
commence with a prefix of CT.  This field will not be filled now. 

Call Number       The order in which bids will be opened for a specified proposal during a 
bid letting.  This field will not be filled now. 

Renewable         A field to indicates if a proposal is to be renewable.  If the Contract ID is 
assigned with a –R0 suffix, assign Y in this field, otherwise assign N. 

Spec Year     The year identifier for Items to be used for the proposed contract.  The default 
value is 04, but will change to 07 in a few months. 

Prev Let As ContID     Indicates the contract ID under which a proposal was previously 
advertised. 

Description         A short description of the proposal. 
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Federal/State Project Number     The federal or state project number identifying a project, 
proposal, or contract.   

Contl PCN         This is the lead project to be associated with the proposal.  Enter the 
Financial Project Number of the lead project. 

Location              The site where work is being performed for the proposal. 

Route Number     The route number or road number of the road that is affected by a project. 

Suppl Spec Year     Not presently in use. 

Road System        A classification of the road.  Select from the drop down menu. 

Proposal Type     A classification for the proposal.  Choose from the drop down list to 
identify a proposal as either to be let in the District or in the Central Office. 

Highway Type     Not in use. 

Bid Method         For Alternative Bidding choose a value from the list box.  Leave the field 
blank if Alternative Bidding is not involved. 

Highway Number     The identifier for the road being worked on in a project. 

Contract Type     A value, selected from the attached CONTTYP code table.  For Production 
contracts, there are nine choices in the drop down list:  

Construction Contracts 
CC Construction Contract 
CDB Construction Design Build 
CEC Construction Emergency Contract 
CFR Construction Fast Response Contract 
CHW Construction Hold Witness Contract 
CLS Construction Lump Sum Contract 
CPB Construction Push Button Contract 

Traffic Operations Contracts 
TO Traffic Operations Contract  
TOPB Traffic Operations Push Button Contract  

Other Contract Types you will see in this table are: 
Maintenance Contracts 

MAM  Maintenance Asset Management 

MC   Maintenance Contract 

MCS  Maintenance Contractual Svcs Contract 

MEC  Maintenance Emergency Contract 

MG   Maintenance Grant 

MMOA Maintenance Memorandum of Agreement 
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MPO  Maintenance Purchase Order 

Primary District     The managing district. 

Contract Work Type     Choose a code from the drop down window. 

Control Group    On adding a new proposal, the personal Control Group will be entered into 
the Control Group field of the proposal header.  If the personal control group contains ? 
or *, change this control group before saving the proposal header.  Enter a Control 
Group composed only of numbers and letters. 

Set Aside Proposal     Leave this field blank. 

Counties              Enter up to four counties for each proposal (select from the drop down 
list).  Trns•port prints this information on some reports, but does not use it in 
processing. 

DBE/MBE Goal (PCT)     Not in use at this time.  A percentage goal set for disadvantaged 
(DBE) or minority (MBE) business enterprises for a proposal.  The default value is 
0.00. 

WBE Goal (PCT)     Not in use at this time.  A percentage amount indicating the goal you 
have set for women business enterprises for the proposal.  The default value is 0.00. 

Proposal Class    Select a value from the attached 
PROPCLS code table.  Run the Work Class 
Percentage Report for the proposal.  Use the 
highest percentage classification, (other than 
MOT or Other) to enter the Proposal Class.  
This step will need to be performed when the 
estimate for the proposal is essentially 
complete.  For lump sum contracts this process 
will be run from the tracking proposal, with the 
values placed in both the tracking proposal and the real proposal. 

Prop DBE Goals     Not in use at this time.  A value, from the attached DBENOTE code 
table that indicates which of the two goals applies to this proposal.  Choose NONE, and 
Trns•port will not print goals on any report.  Choose DBE and Trns•port will only print 
the DBE/MBE goal and will label it a DBE goal.  Choose BOTH, and Trns•port will 
print both the DBE/MBE goal (labeled as an MBE goal) and the WBE goal.  Select 
from the drop down menu. 

Qual.  Classes     There are three fields to identify the proposal work by areas of 
prequalification.  Run the Work Class Percentage Report for the proposal.  Take the 
three highest percentage classifications (other than MOT or Other).  Enter these three 
codes with the highest percentage in the left box.  This step will need to be performed 
when the estimate for the proposal is essentially complete.  For lump sum contracts this 
process will be run from the tracking proposal, with the values placed in both the 
tracking proposal and the real proposal. 
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General Tab Page 2   
Bid Bond     Not used at this time. 

Cost of Proposal Package     Used for 
planholder invoicing in the LAS 
module.  This field shows the 
cost of the proposal package (bid 
blank, plans and specs).  It has a 
default value of 0.0.  This should 
be the cost before taxes.   

Section Assignment     Flag telling 
Trns•port to assign project 
categories to proposal sections automatically or do it manually by entering section 
numbers in the category records.  The default value is Y, which means Trns•port will 
automatically assign categories to sections. 

Cost of Plans      Used for planholder invoicing in the LAS module.  Trns•port will bill this 
cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Special Provisions     This feature is not in use at this time.  It is a flag used to tell Trns•port 
if special provisions will be assigned to this proposal.  The default value is N (no 
special provisions).  Do not change this flag. 

Cost of Specs      Used for planholder invoicing in the LAS module.  Trns•port will bill this 
cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Cost of Proposal    Used for planholder invoicing in the LAS module.  Trns•port will bill 
this cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Min. Order Fee    Used for planholder invoicing in the LAS module.  Trns•port will bill this 
cost to purchasers of complete plans for a proposal.  The default value is 0.00.  This 
should be the cost before taxes. 

Acquis. Time       Used to identify special acquisition times for specialty items required to be 
fabricated under construction contracts. 

OJT Flag            To identify contracts where OJT is required of the contractor.  The Default 
is N for no.   

Special Start Date     Used to identify a delayed start to a contract. 

Proposal Notes     Not in use. 
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If there is only one Project to be attached 
to a Proposal, populate some of the basic 
proposal information by filling in the Cntl 
PCN field and importing the data for the 
Controlling PCN.  This is also applicable 
for the lead project where two or more 
projects are strung together.  For lump 
sum contracts, do this before creating the 
tracking proposal. 

 

After entering the project number in the 
Cntl PCN field, from the Menu Bar, 

• Click Edit > Import Controlling 
PCN Data. 

This will enter information that is 
common from the Project Record.  
District, Pay Item Year, Description, etc.  
This can save some typing if the proposal 
information will be the same as the 
project information, as well as reduce the 
chance of introducing errors. 

A confirmation screen will appear.  To continue,  

• Click Yes.   

To stop the process,  

• Click No.   

This box tells what data will be copied from the Lead 
Project Number.  Once the information is imported, 
change it as necessary. 

The Import Controlling PCN function, 
automatically attaches the project to the 
Proposal and it will appear in the Projects 
Tab.   

 

Page 1 will appear like this when all of 
the necessary fields have been entered. 
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The Description Tab 

After entering the General information, 
move to the Description tab. 

Enter as detailed a description as possible. 

 

The Sites Tab 

A Site in PES is a record that has information about the contract time or times within a Proposal.  
A Site record could represent various physical sections of the Project, like Structures for 
example.  Or, a Site can be any other division of a Project. 

The Site 00 record.  This record will 
contain the total contract time for the 
Proposal, and is required by the system.  
On a new proposal, the tab will be empty 
as seen at the right.  You must add at least 
one row of data.   

 

If the Sites tab looks like this,  

• Rclick in the white space. 

• Click Show Detail.   

This will show all the Site records in the 
top half of the screen and the detail for the 
selected record in the bottom half.  
Always show the detail before adding a 
record.   

The screen will now have a white area in 
the center, and a lower portion in which 
detail will be entered.   

• Rclick to open the Mouse Button 
Menu. 

• Click Add 
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The screen is now ready for Site data.  
Site Number 00 has opened as the default.  
This is the required site to show contract 
time and type of days. 

 

Required fields for the Site Tab are: 

Site Number   Use the default value 
of 00.  

Liquidated Damages per Day     
Liquidated Damages will be 
handled in SiteManager.  There 
is a default value of $1.00.  Do 
not change this value. 

Type of Days   Choose from the drop 
down menu.  The usual choice will be CD from the TIMMETH code table. 

Number of Days    Enter the number of days planned for the work.  If Type of Days is 
chosen to be Calendar or Working days, then a number of days must be entered.  If the 
type of days is Completion Date, then the Specified Completion Date must be entered 
and the number of days need not be entered.  The Site 00 information transfers to 
SiteManager as the Original Contract Days.   

Description      Enter "Contract Time" from the SITEDES code table. 

 

When complete,  

• Click OK 

And the information in the detail panel 
will transfer to the data row in the upper 
portion of the screen.  The Site 00 data 
will look similar to this, unless the 
contract is to be bid under procedure of 
Alternative Contracts.  If it is, see the next 
section. 
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Alternative Contracts 
As noted above, the Site Tab information transfers to SiteManager and may be used for a variety 
of ends including Contract Time, Daily Rates, Incentives, Disincentives, and administrative 
information.   

The Site Tab contains a field named Road User Cost Per Day.  This field is to remain blank 
unless the proposal will be processed under Alternative Contract procedures, in which case it 
will be filled as described below.  When Road User Cost Per Day contains a value, the particular 
Site will be used in the analysis of bids to determine the successful bidder.   

For Time Bid contracts there are three items of information to be retained from the 
preconstruction work.  These are: 

 The engineers estimated duration for the Contract Time or Lane Rental period. 

 The maximum number of days that bidders may bid for the Contract Time, or for the 
Lane Rental period.  This value is in the Contract Specifications. 

 The Road User Cost per Day. 

 

A + B Contracts 
At the General tab, 

• Select the appropriate Type in the 
Bid Method field. 

At the Sites tab enter data in the following 
manner. 

• Site Number   Use the default 
value of 00. 

• Liquidated Damages per Day     
There is a default value of $1.00.  
Do not change this value.  
Liquidated Damages will be 
managed in SiteManager. 

• Type of Days     Choose CD in the 
drop down menu from the TIMMETH code table. 

• Number of Days      Enter the Engineers estimated duration for the contract.  

• Road User Cost Per Day     Enter the daily rate determined for the contract. 

• Maximum Days     Enter the maximum number of days that will be indicated in the 
Contract Specifications. 

• Description      Enter "Contract Time" from the SITEDES code table choices. 

• Click OK to save the record to a data row. 
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During the analysis phase of the bidding, in conjunction with the bids on Pay Items, the value 
contained in the Road User Cost Per Day times the Number of Days identified for the site will 
be used to determine the successful Bidder. 

 

Lane Rental Contracts 
At the General tab, 

• Select the appropriate Type in the 
Bid Method field. 

At the Sites tab create a Site 00 for the 
contract time in the usual manner then 
create additional Sites as described here.  

• Rclick in the white space of the 
Sites Tab 

• Click Add to create a new record. 

 

 

 

Enter information in the following fields: 

• Site Number   Use one site for 
each instance where lane rental is 
to be managed in SiteManager.  
Begin with 01. 

• Liquidated Damages per Day     
Enter the value identical to the 
Road User Cost Per Day to be 
entered below.  This field will 
transfer to SiteManager as a 
Disincentive amount. 

• Type of Days     Choose CD in the 
drop down menu from the 
TIMMETH code table. 

• Number of Days      Enter the Engineers estimated duration for the lane rental time. 

• Road User Cost Per Day     Enter the daily rate determined for the particular Lane Rental 
activity. 

• Maximum Days     Enter the number of days that will be indicated in the Contract 
Specifications.  (The Maximum days). 

• Description      Enter "Lane Rental Days" from the SITEDES code table choices. 



Reference Manual for Production Projects & Proposals PES Release 5.9a                                         Page 72 of 133 

• Long Description 1      If there is more than one instance of lane rental on the contract, 
describe the particular location here. 

• Click OK to save the record to a data row. 

During the analysis phase of the bidding, in conjunction with the bids on Pay Items, the value 
contained in the Road User Cost Per Day times the Number of Days identified for the Site will 
be used to determine the successful Bidder. 

 

Construction Milestones 
For general Construction Milestones 
either with or without Incentives and 
Disincentives, create a Site 00 for the 
contract time in the usual manner.  Then 
create additional Sites as described here.  
Enter data on the Site Tab in the 
following manner. 

• Site Number   Use one site for 
each instance where a milestone is 
to be managed in SiteManager.  
Begin with Site 20 

• Liquidated Damages per Day     If 
there is an incentive for the 
Milestone, enter the value.  This 
field will transfer to SiteManager 
as a Disincentive amount.  The Incentive value will be entered in SiteManager.  
Otherwise enter zero. 

• Type of Days     Choose CD in the drop down menu from the TIMMETH code table. 

• Number of Days      Enter the number of days associated with the particular Milestone.  
Specified Start Date and Specified Completion Date may be used in conjunction with this 
duration.   

• Road User Cost Per day     Leave this field blank, as the Site is not to be associated with 
determining the successful bidder.  

• Maximum Days    Leave this field blank. 

• Description      Enter "Construction Milestone" from the SITEDES code table.   

• Long Description 1     Describe the particular milestone here.  This field may contain up 
to 60 characters. 

• Click OK to save the record to a data row. 
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The Projects Tab 

Attach the Project(s) to the Proposal.  Go 
to the Projects Tab.  If you used the 
Import Controlling PCN function, the 
Cntl PCN will be marked in the Project 
List in the lower window. 

To assign one or more Projects to the 
Proposal, 

• Click the Project or use the 
<Shift> key or the <Ctrl> key to 
select multiple Projects.   

• Click the single Up-Arrow 
button.   

The Projects will appear at the top of the 
screen and are now associated with the 
Proposal. 

If you did not select a Controlling PCN on 
the General Tab, place a check mark in 
the Controlling PCN box. 

Note that all of the projects displayed in 
the lower panel are of the same Unit 
System and Pay Item Year. 

 

 

 Warning: In the Tabbed Folder Change mode, PES has checks to block a project 
from being attached to more than one proposal.  You can make such attachments 
through the Drill-Down method.  DO NOT attach projects to proposals using the 
Drill-Down mode of PES. 

 

Sections Tab 

When entering the Sections tab for the 
first time after attaching projects to it, this 
message box will appear.  It is saying that 
Section and Line numbers need to be 
entered for the Proposal. 

This process rolls up like items and 
categories for the proposal. 
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Click the OK button.   

If the screen has a large area of white as 
seen previously for the Sites tab, 

• Rclick to open the Mouse Button 
Menu.  

• Click Show Detail. 

• Click Generate Sections & Line 
Numbers button 

 

 

 

 

If one of the projects categories contains 
no items, you will receive a message like 
the one at the right.   

Exit the Proposal and correct the problem 
in the Project, by either adding items to 
the Category, or deleting the Category if it 
is not required in the contract.   

• Click OK on the message box,  

• Click the X in the upper right hand 
corner of the Add Proposal 
window and save the Proposal  

Return to the Proposal List window.   

When adding a proposal or a project the first time using Tabbed folders, do NOT try to save the 
proposal or project by choosing File >Save from the Menu Bar, or by clicking the Save       icon 
on the Tool bar.   

After the project data has been corrected, and section and line numbers have been generated, the 
Section Tab will now appear like this with one or more sections.  Review the section 
descriptions, and revise them as necessary.  The default titles are the description of the lowest 
numbered Maintenance Activity for the Categories that made up that Section.   

This description will print on the Proposal Schedule report that is sent to prospective bidders. 

 

The Generate Section and Line Numbers Process 

When initiating the process, Trns•port combines the project categories and project items in the 
following way:   
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• All categories whose FEDCCLS fields are the same will be combined, except when a 
category is an alternate.   

• Items from alternate categories are combined with alternate categories in other projects 
only when the alternate codes for the categories in both projects are identical.   

• Trns•port assigns a unique section number to each proposal section and updates the 
database record for every category to reflect the section to which it is assigned.   

• Trns•port aggregates items within combined categories (proposal sections) when the 
items have the same Item Number and Proposal Supplemental Description.  The 
exception to this is that lump sum items are not automatically flagged to combine. 

• Trns•port removes items that are members of an alternate Item set from the section and 
places them in a section describing the alternate relationship.   

• Trns•port combines alternate items across projects only when identical alternate codes are 
used in both projects.   

• If an Item has been marked to not combine, Trns•port will not combine it.   

The process of generating section and line numbers will roll up the project-level items and 
categories to the proposal level and assign proposal line numbers and section numbers to the 
items and categories.  Trns•port uses the section and line numbers assigned through this batch 
process to generate the proposal items in the Trns•port LAS initialization process.  All proposal-
level reports will use these line number assignments. 

 

The Proposal Items Tab 

The Items Tab will look like this one. 

When a proposal has been set up, 
estimators will want to review the 
proposal-level prices and quantities.  
Estimated prices may change because of 
quantity changes or because the price 
might have changed over time.  View and 
modify the estimated prices through the 
Proposal Worksheet. 

 

The Items tab shows a worksheet similar 
to the one at the project level.  This 
worksheet shows quantities rolled up to 
the proposal level.  If Item price estimates 
were previously specified (with the 
Generate Bid-Based Prices process or by 
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the estimator), a weighted estimated price for each proposal line Item will be displayed.  This 
pricing information is computed from the estimated price and quantities of the individual 
occurrences of the items that were combined into that proposal line Item. 

Change the estimated price in the Price field as necessary.  However, no other information may 
be changed in this worksheet.  If quantities are to be changed, they must be changed in the proper 
project.  If you change a price inadvertently, press ESC before you leave that field so that it will 
revert to the original price.  Trns•port recalculates the extended amount according to the new 
price you enter.  When you finish making changes, click the window again. 

When you close the window, Trns•port displays a dialog box.   

• Click YES to save the new prices,  

• Click NO to return to the Proposals List window without changing prices, or  

• Click CANCEL to return to the Proposal Items tab window to make other changes.   

When you save, Trns•port will send the new prices back to the project level.  Each proposal line 
price estimate will be redistributed to each of the project Item records that combine into that 
proposal line Item. 

 

Proposal Level Reports 

Generating a Preliminary Detail Estimate 

To run a Preliminary Detailed Estimate at 
the Proposal Level 

• Rclick to open the Mouse Button 
Menu.   

• Click Run Process  

 

 

 

 

 

 

 

 

• Click Generate Preliminary Detail Estimate. 
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A window opens to choose which parts of the report 
are needed.   

• Uncheck boxes that are not needed. 

• Click Submit. 

 

 

 

 

Generating the Proposal Schedule Report (Bid Blank) 

The Estimator will have the capability of generating the Proposal Schedule Report (bid blanks).  
This should be done to verify that all of the items and sections rolled up as desired and that non-
bid and fixed price items were appropriately marked.  In addition, it is possible that the Estimator 
will want the change the estimated unit price for an item after they see the rolled up quantity. 

To run the Proposal Schedule Report,  

• Rclick to open the Mouse Button Menu.  

• Click Run Process  

• Click Generate Proposal Schedule. 

A window opens to choose which parts of the report are 
needed. 

• Uncheck boxes that are not needed. 

• Click Submit. 

If you check the Proposal Estimate Box you 
will see the estimate for the proposal with the 
unit prices and extended amounts filled in the 
same format the Bidders will see when they 
enter their prices. 
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Electronic Proposals and Addenda 

All central Office and many District Office let contracts will be produced and distributed on 
electronic media.  When the proposal processing has reached the stage of transferring control of 
the proposal to the Contracts Administration Office, the electronic proposal may be prepared.  
All of the processes of creating electronic proposals and addenda are performed in the Contracts 
Administration offices (Central Office and District Offices).  The Proposal will have been 
attached to a Letting Header and the proposal initialized into LAS. 

 

Creating the Proposal 

Begin in the Proposals List window as 
seen here.   

• Click the Proposals(s) to be 
prepared. 

• Rclick Run Process. 

 

 

 

 

• Click Generate Proposal Schedule. 

 
 

 

 
The Proposal Price Schedule Options window will open.  
It is the same window used to create a paper 
proposal schedule. 

• Check the box labeled Generate Pass 
File to EBS. 

• In the EBS Pass File Name field leave 
the entry UserId.txt. 

• Click Submit. 

Wait until the Status Monitor reports that the process has 
completed.  An electronic proposal flat file is now 
located on a Trns•port server. 

• Click OK to close the window. 
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Download Files 

Download the file(s) from the Trns•port system 
and move them to a new location.   

From the Menu Bar, 

• Click Utilities > Download File > 
Process I/O File. 

 

 

• DblClick the directory qebsfnamdir. 

 

 

 

 

In the File Name window, 

• DblClick your userid.txt. 

 

 

The Save I/O File window will open for you to 
choose file location and name.  Click the 
Navigate Up        icon until you reach this screen: 

For Central Office processing, 

• Choose the folder labeled 
CO_Expedite_Sys on 'Dotvcofp001' (R:). 

• Click Open. 

For District processing, the file structure is built 
in a similar manner, but the CO is be replaced by your district number. 

Caution: These next steps will copy the newest 
version of userid.txt and overwrite 
previous versions.  Be sure that 
previous downloads of userid.txt have 
been processed by the Expedite Gen 
module, and the EBS files placed in 
their proper folders. 

This screen will now open to accept the new file. 

• Click Save. 
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Next, you will receive this warning/confirmation message 

• Click Yes to overwrite the file. 

 

 

The electronic proposal(s) is now complete and available for the Contracts Administration Office 
in either the Central Office or a District Office to prepare discs for delivery to prospective 
bidders using the Expedite program and its modules.  The Gen module of Expedite will convert 
the userid.txt file into another format useable by bidders. 

 

Electronic Addenda 

Once the job has been advertised and proposals distributed to prospective bidders, all changes to 
the proposal will be made by addendum.  

When the addundum has been processed, run the Generate Propsal Schedule again.   

• Check Proposal Cover Sheet to see a 
paper version. 

• Check Proposal Schedule of Items to 
see a paper listing. 

• Check the box labeled Generate Pass 
File to EBS. 

• Click Submit. 

The remainder of the steps are the same as the creation of the original file above.  After the Gen 
module in Expedite transforms the file for bidder use, an additional file for each addendum will 
be included. 

Web Reports 

In addition to standard reports within PES 
reports have been created that are 
accessible from the FDOT Intranet.  At 
the URL: 

http://www3.dot.state.fl.us/trnsport2/ 

you will see this Log In screen.   

 

 

• Enter your user ID and Password 

 

http://www/


Reference Manual for Production Projects & Proposals PES Release 5.9a                                         Page 81 of 133 

 

You will see a list of Designer and Pre 
Letting Reports.  Depending on your 
access security, you may have a different 
list.   

 

 

 

 

 

Project Edit Report 

If you select the Project Edit Report, you 
will get another login screen. 

 

 

 

 

• Enter a FinProj Number  

• Click Submit 

 

 

 

 

 

A report in Adobe PDF format will be 
generated such as this one which was 16 
pages.  Note that two Items are identified 
as Obsolete. 
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Proposal Summary of Pay Items 

To run the Proposal Summary of Pay 
Items  

• Click Proposal Summary of Pay 
Items 

• Enter the Proposal ID in the Input 
Data field. 

• Click Submit. 

• Click Refresh after the report has 
time to run. 

• Click View to see the report. 

 

 

 

The report is seen at right. 

 

Other reports in this series are 
generated in a similar manner. 
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Cross Walk Report 

The crosswalk report is a search tool to 
find related information from one known 
item.  In this example a search of all 
Proposal IDs on a particular letting 
(03041021) is sought. 

 

 

 

 

 

 

 

This report is the result. 

 

Preparing to Advertise 
District Let Contracts 

When the proposal is complete and ready 
to transfer to the district contracts office, 
open the Proposal Header and change the 
Access Control Group from CD## to 
CL##.  At the same time open the project 
headers of all associated projects and 
change their Control Groups to CL##.  
The District Contracts Administration 
Office will then initialize the proposal in 
LAS and prepare the advertisement 
documents. 

 

Central Office Let Contracts 

When the proposal is complete and ready 
to transfer to the central office, open the 
Proposal Header and change the Access 
Control Group from CD## to CC##.  At 
the same time open the project headers of all associated projects and change their Control 
Groups to CC##.  After initial processing in the State Estimates Office, the proposal and project 
Control Groups will be changed to CT##.  The Contracts Administration Office will then 
initialize the proposal in LAS and prepare the advertisement documents. 
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Creating Addenda in PES 

After a Proposal has been advertised, all future changes to the project/proposal scope must be 
made through an Addendum. 

Remember that it is very important to accurately assign Project Line Numbers and Proposal Line 
Numbers to each Addendum Item to be added.  You will need copies of the proposal level 
Preliminary Detailed Estimate, the Proposal Schedule, and the Generate Section and Line 
Numbers (Inquiry) reports to do this accurately. 

Create an Addendum, from the Proposal List window. 

• Click the proposal 

• Rclick to open the Mouse Button Menu. 

• Click Addendum List. 

A window listing all addenda for the 
proposal will open.  First create an 
Addendum Header and then add 
Addendum items. 

To create an Addendum Header 

• Rclick anywhere in the white 
space to open the Mouse Button 
Menu.  

• Click Add. 

 

 

The Addendum Number is automatically 
assigned, commencing with 0001.   

• Enter the Date of the Addendum 
in MM/DD/YY format. 

• Enter a Description up to 60 
characters in length. 

• Click OK when done. 
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Adding New items 

To add the Addendum items, 

• Rclick the Addendum row to 
open the Mouse Button Menu. 

• Click Addendum Items. 

 

 

 

 

• Rclick in the white space to open 
the Mouse Button Menu. 

• Click Add. 

• Click New Item to add an item to 
the proposal.   

Other choices are: 

Add>Modify item Add>Remove 
item 

In this example we will add an item. 

On this screen enter in sequence: 

• Project No., by selecting from the 
down arrow. 

• Category Number by selecting 
from the down arrow. 

• Project item Line No. that does 
not already exist.   

Recall that Project Item Line Numbers are 
initially generated in steps of five.  These 
gaps allow the insertion of addendum 
items in their logical order.  Examine the 
project worksheet or a copy of the 
Preliminary Detailed Estimate and select 
an appropriate line number. 
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• A Pay Item Number from the drop 
down arrow, which opens the 
Master Pay item file. 

• The Quantity for the added item. 

• Proposal Line Number.  Examine 
a copy of the Proposal Schedule 
and determine where the item 
should be displayed, and enter an 
appropriate number.   

 Note:  If an item being added is a 
State Furnished Item, be sure to 
mark the flag Non-Bid Item.  In 
this special case, the Proposal 
Line Number must be left blank. 

When these steps are completed,  

• Click OK if there is only one item to Add or 

• Click Add More if other items are to be added. 

 

Modify Existing Items. 

If the addendum is to modify one or more item, choose Add > Modify Item above. 

In this widow: 

• Click the Project Number from the down arrow. 

• Click the Category Number from the List Box 

• Click the Project Line Number from the List Box (the Pay item and Proposal Line 
Numbers are now identified). 

• Enter the corrected quantity. 

• Click OK or Add More if other item quantities are to change. 
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Deleting items 

If an item is to be deleted, choose Add > Remove Item above.   

In this window in sequence Click: 

• Project Number from the down 
arrow 

• Category Number from the down 
arrow 

• Project item Line Number from 
the down arrow. 

The deletion is now fully detailed, as all 
other fields on the window are blue. 

Addendum items WILL NOT show in the 
Items Tab in the Proposal Folder.  The 
Addendum items WILL show on the 
Proposal Schedule Report. 

 

 

Generating the Proposal Addendum Report 

To produce the Proposal Addendum 
report: 

• Click the Proposal from the 
Proposal List window. 

• Rclick to open the Mouse Button 
Menu. 

• Click Run Process 

• Click List Proposal Addendums 

• Click OK. 

Submit the process. 

If any changes to a Project or Proposal are made after it has been initialized in LAS, the Proposal 
will need to be re-initialized in LAS. 

 

Sending the Proposal to LAS 

When it is time to send the Proposal to Contract Administration for Letting the Control Group on 
the Proposal and the Projects should be changed to be the Contract Administrators Control 
Group and the Estimator should notify the Contracts Office so they can initialize the Proposal in 
LAS and attach it to a Letting.  Once the Control Groups are changed, the Estimator will no 
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longer be able to access that Proposal or its Projects.  If Addenda need to be added to the 
Proposal, the Contracts Administrator will need to change the Control Group on the Proposal 
back to the Estimator’s Control Group. 

 

Running the Bid Tab Analysis Report in LAS 

Because of the confidentiality of the Estimate, it may be the Estimators responsibility to run the 
Bid Tab Analysis report in LAS. 

To start LAS,  

• DblClick the LAS Icon on the Citrix Screen. 

• Enter the PES/LAS UserId and password. 

• Click OK. 

LAS will open in much the same manner 
as PES. 

Open the Bid Letting list window by 
clicking on the icon that looks like an 
envelope.  

Then  

• Rclick the desired Letting to open 
the Mouse Button Menu.  

• Click Letting Proposal List. 

The Letting Proposal list window will 
open. 

• Rclick the desired Letting 
Proposal to open the Mouse 
Button Menu. 

• Click Run Process. 

 

 

• Click Generate Bid Tab Analysis. 

• Click OK. 
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For the first run, select all reports including the 
Engineer’s Estimate. 

 

This set of reports will show the Engineer’s 
Estimate on the reports in comparison to the 
bidders' prices.   

• Click Submit. 

The second time you run the reports, do not 
check Include Engineer’s Estimate. 

This second set of reports will be given to the 
Contracts Administration Office.   

• Click Submit. 

 

Rejecting Bids 

When the situation arises that bids are to be rejected and a contract is to be re-advertised the 
process will begin in the Contracts Office.  Certain fields in the Letting process will be re-set to 
indicate that the bids are being rejected and the contract re-advertised. 

 

The Old Proposal Header 

Contracts Office 

• Change the Access Control Groups of the proposal and all associated projects from 
CL## to CD##, or from CT## to CD##, as the case may be, so that the district estimator 
who created the Proposal Header will be able to update the projects and create a new 
Proposal Header for the re-advertisement. 

District Estimator 

• From the Proposals List window, highlight the proposal to be modified. 

• From the right mouse button menu, select Tabbed Folder Change.   

• Go to the Projects tab and select the single or double down arrow to remove the project(s) 
from the proposal.   

• After removing the project(s), close the proposal and save the file.  This process makes 
the project(s) available to be attached to a new Proposal Header. 

• Change the Access Control Groups of the proposal from CD## to CL##, or to CT##, as 
appropriate.  The old proposal header will then be available in the appropriate contracts 
administration office for history purposes. 

• When the Save confirmation message opens, click YES. 
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The Projects 

Make any changes to the projects(s) that may be necessary.  Particularly, if there were any 
addenda to the original proposal, enter all changes into the projects.  Be sure to assign new 
Breakdown Item Line Numbers and Project Item Line Numbers.  If this is a Lump Sum 
contract these corrections will be made to the Tracking Project(s) 

 

The New Proposal Header 

• From the Proposals List window, select Tabbed Folder Add from the right mouse button 
menu.   

• In many cases, using the Copy Special feature for projects, categories, and proposal can 
save steps.  In this case, however, it is important to NOT use the Copy Special feature.  
If the original proposal had addenda attached to it, the number of the last addendum 
issued, would be recreated on page 2 of the new Proposal General tab.   

• When the new Proposal general tab window appears: 

o Go to the Cntl PCN: field, and from the list box select the lead project. 

o From the Menu Bar, choose Edit > Import Controlling PCN data. 

o Enter the new Proposal Identifier (“E” Number). 

o Click the page 2 radio button,  

o Enter the Old Proposal Number into the Prev. Let As ContID field.  

o At the Projects Tab, Highlight any additional project or projects to be connected to 
the new Proposal Header.   

o Click the single up arrow.   

o Click the Items tab.  A warning window will open indicating that changes have been 
made to the proposal  

o Click OK. 

o Click the Generate Section and Line Numbers button at the bottom of the window. 

The reconstructed proposal Item information will appear in the Items tab. 

• Save and close the tabbed folder by clicking the "X" for the tabbed folder window. 
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Appendix A Glossary 

AASHTO American Association of State Highway and Transportation Officials.   

Ability Factor The state's numerical rating of the vendor's capability to perform work.  t is a 
factor in calculating the vendor's capacity; it is not a performance evaluation.  See also Adjusted 
Net Worth and Capacity.  This information is used in the CAS module.   

Access Control Group Each user and each project and contract can be assigned a Trns•port 
control group code.  A given user only has access to those projects and contracts that have the 
same control group as the user.  (See Control Group)  

Account Number The account number of the contractor who is setting up a securities account.  
This number could be the same as the contractor's vendor number (as maintained in the Vendor 
file) or the Contract ID number, depending on the Trns•port installation setting.   

Accounting Fund Code The accounting department's code for a fund when it differs from the 
Trns•port code.   

Accounting Project Number A code the Accounting department can enter for projects.   

Acquis. Time Available to indicate to bidders that acquisition time is available to procure long 
lead-time items such as mast arms or other items needing to be fabricated. 

Action The type of action (add, change or delete) to be performed by an addendum item.   

Active Project The open or highlighted project (of possibly many) that commands will affect.   

Active Window The open window (of possibly many) that commands will affect.   

Addendum After sending proposals to planholders, handle subsequent changes through 
modifications called addenda.  Addenda allow modifications directly into the system to apply 
changes to the proposal information before the bid letting.  Send a copy of each addendum to 
planholders as soon as possible so planholders can incorporate the changes in their bids.   

Addendum Date The date the addendum is added or becomes effective.   

Addendum Description A short description of the proposal addendum.   

Addendum Number The sequential number identifying a proposal addendum.   

Addendum Project Item Line No.  A unique sequential identifier for an item within a 
project.  Choose a value from the attached drop down list.  When you select a category number, 
Trns•port fills in the Project item Line Number list with all Project item line numbers for the 
selected project and category. 

Additional Vendor Name A field for an additional name of the vendor.   

Add-On An adjustment to the pay items of a contract after the award is made.  This adjustment 
is something other than a formal supplemental agreement.   

Address Sequence Number A sequential number used to identify one of multiple addresses 
for a single vendor.   

Address The address of the district, area office, field office, or residency.   



Reference Manual for Production Projects & Proposals PES Release 5.9a                                         Page 92 of 133 

Address Type A coded value indicating the type of address for the vendor (for example, 
billing or shipping) when a vendor has multiple addresses.   

Adjusted Net Worth The total value of the vendor’s assets minus the total value of its debts.  
This number can represent the agency’s estimate, the vendor’s claim, or an audit amount.   

Adjustment Code Not in use by the Department at this time.  A coded value (which must be 
in the ECTGPCT code table) indicating the percent to be used for any additional adjustments.  
The adjustment fields act like E&C percent (for example, gross receipts tax percentage).   

Adjustment Item Changes to a construction contract item after award, which can include 
incentives, disincentives, and liquidated damages.   

Adjustment Percent Not in use by the Department at this time.  A percent adjustment made to 
the category, which is applied to the total category construction cost to compute the total 
category amount.   

Adjustment Type Code A coded value (from the ADJTYP code table) indicating the kind of 
price adjustment being applied to the item.   

Administrative Unit Not used in Trns•port processing but printed on some reports.  Values 
must be in the STAFF code table.   

Advance Account If your state allows contractors to set up accounts for contractors, this field 
holds that number.  It is not used for any Trns•port processing.   

Advance Account Number If the state allows contractors to set up accounts for contractors, 
this field holds that number.  It is not used for any Trns•port processing.   

Affiliate Vendor Number The name of the vendor associated with another vendor.  All 
references to vendors are validated with the Vendor file.   

Affiliates Two Vendors that are legally related to one another in an ongoing way.  The 
Affiliates can be parent and subsidiary, or substantial owners of each other’s stock.  Two 
Vendors who engage in a single joint venture are not considered Affiliates.   

Agency A specific agency that provides funding for a specified purpose (for example, bridge 
rehabilitation).   

Alternate Item ID A separate item code used in public documents or communication with other 
systems if the regular item number is inappropriate.  For example, the regular item code might be 
too specific for public documents.   

Alternate Item Number ID Not in use by the Department at this time.  A separate item code 
used in public documents or in communication with other systems if the regular item number is 
inappropriate.  For example, the regular item code might be too specific for public documents. 

Alternate Project ID Not in use by the Department at this time.  A code that identifies a 
project in some electronic or manual system outside of Trns•port.  Trns•port can use this value to 
communicate with that external system.   



Reference Manual for Production Projects & Proposals PES Release 5.9a                                         Page 93 of 133 

Alternate Vendor ID A code that identifies a vendor in some electronic or manual system 
outside of Trns•port.  This value can be used by Trns•port to communicate with that external 
system.   

Alternate Vendor Number An alternate identification number or code for a vendor.   

Amendment Another name for an addendum.   

Amount Due to Date The total amount presently due for payment to the contractor for a given 
project.   

Amount Encumbered The dollar value of securities being withheld by the state to cover 
retainage requirements to date for a contract or vendor (see Securities Account for a description 
of the agency's options).  This is the amount withheld from payments if there is no securities 
account or if the securities account had insufficient funds.  The total of all Amount Encumbered 
values for a particular securities account is limited by the current value of securities on deposit in 
the account.   

Amount Further Subbed (Actual) The dollar value of all child or "sub-subcontracts" of a 
subcontract, which is based on the actual amount agreed to by the subcontractor with the sub-
subcontractors.  Because the actual agreements between subcontractors and their sub 
subcontractors might not be known to the agency, this value might not be meaningful.   

Amount Further Subbed (Contract) The dollar value of all child or "sub-subcontracts" of a 
subcontract, which is based on the contract prices for all items.   

Amount The amount of the transaction.   

Approval Date The date the vendor was approved for work.   

Approval Flag A notation indicating the acceptability of the vendor to work on the contract.   

Approximate Percent of Project Length The percentage of the project (measured in 
physical length or size, duration, dollars, or other characteristic of choice) that occurs in the 
indicated county, city, or congressional district.  This value is used to estimate the value of 
projects in selected geographical areas.   

Area A portion of the state that consists of one or more counties in their entirety.  Each Area 
belongs to exactly one Area Type.   

Area Type A specification for partitioning the state into Areas.  The Areas in an Area Type 
must be disjoint (have no overlap) and, when combined, must include every part of the state.  
Different Area Types partition the state in different ways for different reasons; for example, Area 
Type "Steel" might partition the state by variations in steel prices while Area Type "Asphalt" 
would be a different partition by variations in asphalt prices.   

Ascending List order such that the first character of each successive list element has a symbol 
that occurs later in the alphabet or number system than the preceding element.  The list of 
numbers 10, 20, 40 and the list of codes A25, C11, Z44 are in ascending order (see Descending).   

Authorization An official authorization approval of a recommendation.   
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Authorized Payment Limit The maximum amount that can be paid to a contractor for a given 
project.   

Automatic Payment (Auto-Pay) Item Items, such as mobilization, with set schedules for 
voucher payment as determined by the basis of work on a contract.   

Automatic Payment Specification The rules governing the rate of payment of Auto-Pay 
Items.  Typically of the form "When the contract reaches X% complete, pay Y% of the item."  

Automatic Section Assignment Flag This field tells Trns•port to assign project categories 
to proposal sections automatically or do it manually by entering section numbers in the category 
records.  The default value is Y, which means Trns•port will automatically assign categories to 
sections.   

Auto-Pay Item See Automatic Payment Item.   

Average Pavement Depth The average depth of the pavement in the roadway portion of the 
proposal.   

Average Pavement Width The average width of the pavement in the roadway portion of the 
proposal.   

Average Price The weighted average unit price bid for a particular item.  The item bids 
analyzed will usually be grouped according to similar proposal or proposal item characteristics.   

Average Unit Price (AUP) Work Type Used to determine average unit prices.  One of nine 
work types related to a specific project.  Trns•port uses this field to help generate bid-based 
prices for the project items.   

Award Contract Amount The dollar amount originally awarded for a contract.   

Award Date The date a contract was actually awarded to a contractor.   

Award The contracting authority's acceptance of a bid subject to the execution and approval of 
the contract.   

Awarded Amount The dollar amount awarded to the winning bidder for a proposal.   

Awarded Vendor Number The vendor number of the winning bidder for a contract.   

Batch A computer process that runs by itself with no user interaction.   

Beginning Termini Defines more precisely where the project is taking place with notation 
defined by your agency.  This data, which is printed on some reports, is passed to Trns•port 
BAMS/DSS to pinpoint the project on maps.   

Bid A sealed written instrument conveyed to the Department by a bidder that details the bidder's 
offer to handle the construction work outlined in a proposal for a price included in the bid.   

Bid Alternate A portion of a proposal that contains two or more groups of items for which the 
bidder must bid on at least one of the group.   

Bid Bond A dollar amount required to bond contractors.  This field is printed on some 
Trns•port reports but not otherwise used in any processing.  The default value is "0".  Do not 
change it. 
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Bid Edit Status Indicates if the automated bid editing process detected any errors in the bid 
(such as incorrect arithmetic).   

Bid Letting An event at which a Department staff person opens and reads all bids for specific 
proposals, determines the winning bidders, and awards contracts.   

Bid Letting Control Number The value Trns•port uses to uniquely distinguish the bid letting.  
It does not need to relate to other Trns•port data values in any way.   

Bid Letting Package A group of proposals processed in a single bid letting.  After you define 
proposals, assign them to a bid letting package.   

Bid Note A description field to store textual notes (brief written comments) about a particular 
bid for a letting.   

Bid Note Sequence Number A sequential number Trns•port generates whenever you add 
notes about a bidder.   

Bid-Based Prices Unit prices for work items that are derived from estimated historical bid 
prices.  This process uses either regression or weighted averages that are based on data generated 
by the Trns•port BAMS/DSS PEMETH model.   

Bidder A vendor who submits a bid on a proposal.   

Bill-to Address Number The sequence number of the planholder's billing address.  Trns•port 
references the address information in the VENDADDR file.   

Bi-Weekly Estimate The estimate the engineer generates every two weeks for a particular 
project.   

Break Item Quantity The recorded quantity of a work item at the plansheet level.  These 
quantities will be rolled up to the estimate item level.    

Break Item The portion of a regular/structure/sewer item assigned to a particular plansheet.   

Breakdown A detailed description or graphic of a section of work performed in the project.  It 
can contain sketches, items, and quantities.   

Breakdown ID A unique identifier for the breakdown within a project.  If the default value of 
"1" does not appear, enter a value of "1".   

Breakdown Item Line Number The line number identifying the breakdown item.  This is 
usually a number sequenced for the items within a single breakdown.  This number is 
differentiated from the Project Item Line Number, which may include more than one Breakdown 
Item Line Number.  This field can be entered automatically.  See “Assigning Line Numbers". 

Breakdown Item Quantity Enter the quantity for the Item. 

Breakdown Type A code table indicating the plansheet might be of a certain type or contain 
certain data (for example, roadway, bridge, structure or sewer).   

Bridge ID A unique identifier for a bridge structure.   

Bridge Length The length of a bridge.   
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Bridge Type A value selected from the attached BRDGTYP code table that indicates the type 
of bridge (e.g., Overpass, Trestle Low, etc.). 

Bridge Width The width of a bridge structure.   

Calculated Bid Total Trns•port calculates the vendor bid total by checking various figures on 
the vendor's bid tabulations.  Trns•port calculates and sums item extended amounts or sums 
vendor section totals according to an installation option.  This figure should be the same as the 
Proposal Bid Total.   

Call During a bid letting, the person in charge of the letting calls each proposal in a pre-specified 
order so bidders can submit their bids.  For bid lettings, the terms call and proposal are often 
used interchangeably.  Trns•port identifies each call by a three-digit number.  Many reports in 
Trns•port LAS list proposals in call order.   

CAS Contract ID The label used to identify proposals to be combined into one contract.   

Cash/Charge Code A coded value (which must appear in the CHRG code table) indicating 
the method by which the plans were purchased.   

Category A subdivision or grouping of items within a project.  Each category represents a 
collection of related work items that have the same agencies with the same participation.  Each 
category can have one or more funding sources (funds).  Associate each category with a 
particular unit of work in the project; that is, group all items for a single structure into a single 
category.  Each category should contain items belonging to the same class of work and E&C 
percentage.  Use categories to group items by alternate design possibilities.    

Category Adjustment Code A coded value (which must be in the ECTGPCT code table) 
indicating the code for a percent to be used for any additional adjustments.  The adjustment 
fields act like E&C percent (for example, gross receipts tax percentage).   

Category Adjustment Percent A percent adjustment Trns•port will make to the category.  
Trns•port applies this percent to the total category construction cost to compute the total category 
amount.   

Category Alternate Code Different categories can be alternates for each other, which means 
that a bidder can choose to bid on either category but not both.  The code you enter here indicates 
that this is an alternate category.  The first two characters specify the alternate group and the 
third character specifies the alternate number.  The Category Alternate Code field and the 
Federal Construction Class field control the generation of section numbers for the proposal.  If 
categories have the same Federal Construction Class and Category Alternate Code, they will be 
combined into a single section.   

Category Depth The average pavement depth in inches/cm.   

Category Description A short description of a category’s purpose (e.g., funding agencies) 
used as default label for proposal section description.  Required by the system; should contain 
the code description that is found with the Category Work Class field for the Maintenance 
Activity Number chosen.  Enter the description from the Category Work Class description. 
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Category Length The length of the category in miles or kilometers.  This quantity will be 
printed on some reports as an overall project length.  You may assign the full length of the 
project in any category, or you may split the length among categories so that the combined 
length is equal to the overall project length.  Enter in miles or kilometers.  The default value is 
0.0000. 

Category Number A four digit number Trns•port uses to identify the category.  Enter the 
Category Number from the list box.  A range may be entered all at once. 

Category Width The width of the portion of the project represented by a given category.  The 
default value is 0.0000. 

category.   

Catg. Suppl Work Code Similar to the Federal Work Category except that Trns•port uses the 
FEDSUPP code table.  A coded value indicating the type of federal work performed in a 
category. 

Change Order A written order issued by the engineer to the contractor.  It covers permissible 
adjustments and minor plan changes or corrections, rulings with respect to omissions, and 
discrepancies or intent of the plans and specifications.  It does not include any extra work or 
other alterations covered by the supplemental agreement.   

Check Box A dialog box component that allows selection of options.  Select none, some, or all 
of the available check boxes (see Radio Button and List Box).   

City The city in the district address.   

Classification Function A coded value indicating the classification or category into which 
the item fits.  Used by Trns•port BAMS/DSS to group items into the same market share.   

Clerk Writing Order A coded value indicating the person who took an order for the purchase 
of plans.   

Clicking Pressing and releasing one of the mouse buttons, usually the left button.   

Combine Flag Trns•port will take several different category items and combine them into a 
single proposal line item under certain conditions.  To stop Trns*port from doing that, enter an 
`N' for this field.  That will force Trns*port to create a separate proposal line item for this 
category item.  Trns*port will combine different category items into a single proposal line item if 
they match in five fields: the item number, the supplemental description, the item alternate code, 
the supplemental proposal description, and proposal section number. 

Combine with Like Categories The default value for this flag is YES.  Do not change this 
flag.  Trns•port can combine several categories into a single proposal section according to some 
simple rules.  If you do not want that to happen, force Trns•port to put all the Items in this 
category into their own proposal section.  If the check box is marked, then Trns•port combines 
all the Items into a single proposal section.  This field in conjunction with the Combine with Like 
Items flag controls the rolling up of item quantities for bidding. 

Combine with Like Items Trns•port combines category items into a single proposal line item 
if they match in four fields: the item number, the supplemental description, the item alternate 
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code, and the supplemental proposal description.  If you check the Combine with Like Items 
check box, each item will only appear once in the proposal, even if you list it in more than one 
category.  Trns•port will combine items if the item code (if filled in) is the same and if the 
alternate code and supplemental descriptions match exactly.  If you remove the check from the 
check box, Trns•port will not roll up the items.  Items that meet these criteria must reside in 
categories that have the same federal construction class (proposal group) to be rolled up into the 
same section of the proposal. 

Command Button Part of a dialog box that executes a command when you choose the button.   

Commitment Amount The total dollars committed to the DBE/WBE vendor.   

Common Unit of Measure A coded value from the attached UNITS code table indicating the 
common unit of measure to which Trns•port can convert the item for comparison to other items.   

Completion Date If the Type of Days field is set to DT, this field tells what the completion 
date is.  See Specified Completion Date.   

Construction Engineering Percent (C & E Pct) Not in use by the Department at this time.  
The default value is 0.00.  Do not change it.  The amount of construction engineering work to be 
performed on a project expressed as a percentage of the total category or project amount.  If you 
put a zero in the Construction Engineering Percent field, Trns•port will assume that you mean 
0%.  Trns•port leaves the field blank by default and assumes the C&E percent is the same as for 
the project as a whole.  

Cont Alt ID 1 Use this field and Cont Alt ID 2 to store identifiers the agency will use for this 
contract in addition to the Contract ID Trns•port requires.  Trns•port does not use this field in 
any Trns•port processing.   

Cont Alt ID 2 Use this field and Cont Alt ID 1 to store identifiers the agency will use for this 
contract in addition to the Contract ID Trns•port requires.  Trns•port does not use this field in 
any Trns•port processing.   

Contract ID A unique identifier for a proposal or contract.  Enter the planned District or Central 
office Contract number, and use it as a Proposal Identifier.   

Contract Proposal See proposal.   

Contract The written agreement between the contracting authority and the contractor that sets 
forth the obligations of the parties, including performance of work, furnishing of labor and 
materials, and basis of payment.  Trns•port creates a contract from a proposal when you let and 
award the proposal.  The contract contains all the proposal information needed to manage 
construction and pay for construction work.  Like proposals, contracts consist of projects and 
sites.  Contracts also contain item payment information, voucher information (including 
retainage and liquidated damages), contractor performance and schedule information, and 
subcontract and DBE/WBE commitment information.  You can modify the contract as the work 
progresses (see add-on, supplemental agreement, and change order).   

Contract Type A value selected from the attached CONTTYP code table, that you use to store 
a classification of the type of contract this proposal will become (e.g., a maintenance 
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construction or traffic operations contract).  Trns•port prints this field on some reports but does 
not use it in processing. 

Contract Work Type A coded value your agency can use to store a classification for the work 
type for this contract.  For Maintenance contracts, leave the default value "I" – Other.  For other 
contracts, choose a code from the list box. 

contract.   

Contracting Classification A value selected from the attached CONTCLS table that 
indicates the class of contract. 

Contractor Bid A bidder's offer to perform the work in a proposal for specific unit prices 
specified by the contractor.   

Contractor Info A contractor that submits a response to The Department's proposal and offers 
to perform the work for specific unit prices.   

Contractor The winning bidder to whom you award the contract.  Any business entity that 
interacts with The Department; for example, bidders, contractors, subcontractors, material 
suppliers, escrow agents, railroads, utilities, and consultants are all contractors.   

Control Group A group of users who can access the same set of projects, proposals, or 
contracts (e.g., only users in the Estimates control group can access Estimates projects).  Each 
control group member may only view, change, and delete projects, contracts, or proposals in 
their own control group.  To pass a project, contract, or proposal to another control group for 
processing, a user can change its control group code to the new group code.  When the user saves 
the project, contract, or proposal, the original control group will no longer have access to it.  
Trns•port will automatically enter the control group of the user who signed on and added the 
project in the Control Group field.  For example, if an Aeronautics user with a control group of 
A1 adds a project, the project’s control group will be A1 and only other users in the A1 control 
group or less restrictive control groups (*1, A* or *) will be able to view, change, or delete the 
project.  To pass a project to another control group for processing (e.g., from Estimates to 
Contracts), a user in the first control group can change the control group code to the new code.  
After the first user saves the project, the first control group will no longer have access to the 
project.  If you put a specific control group in the field and save the project, only users with a * 
control group (they can view all projects) can access the project and change the control group. 

Control Menu Every window has a control menu, which contains commands that change the 
size of, move, or close the active window.   

Control Section The Control Section is a geographical reference system used to identify the 
location of the project.  The first two positions are the county and the last three the section in the 
county.   

Controlling PCN Indicates which project is the controlling project in a multi-project contract.  
Enter the Financial project Number of the lead project. 

Conversion Factor to Common Units Trns•port multiplies this conversion factor by the 
item quantity to convert the item units to the common unit of measure.   
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Conversion to Common Units This conversion factor is multiplied by the item quantity to 
convert the item units to the common unit of measure.   

Cost of Plans Used for planholder invoicing in the LAS module.  If there is a charge for plans, 
enter the cost of the plans only, exclusive of sales tax.  The default value is 0.00. 

Cost of Plans without X-Section Not in use by the Department.  Used for planholder 
invoicing in the LAS module.  Trns•port will bill this cost to purchasers of complete plans 
without cross-references for this proposal. 

Cost of Proposal Package     Used for planholder invoicing in the LAS module.  If the 
district charges for plans, enter the cost of the complete package of bidding documents, exclusive 
of sales tax.  This field has a default value of 0.00. 

Cost of Proposal Used for planholder invoicing in the LAS module.  Trns•port will bill this 
cost to purchasers of plans for this proposal.  The default is $0.00.  The next fields—Cost of 
Plans, Cost without X-Section, and Cost Per Plan Sheet—are used for the same purpose.   

Cost of Specs Used for planholder invoicing in the LAS module.  If there is a charge for 
specs, enter the cost of the specs only, exclusive of sales tax.  Default is 0.00. 

Cost Per Plan Sheet Used for planholder invoicing in the LAS module.  If the district charges 
for plans, enter the cost of the specification package only, exclusive of sales tax.  Default is 0.00. 

Cost Plus Time Bidding A bidding method that involves time with an associated cost in the 
low bid determination.  This type of bidding consists of the traditional work items and represents 
the total contract amount.  The Time component is a bid of the total number of calendar days the 
bidder will require to complete a milestone.  Both the work items and the Cost Plus milestone 
components appear in the bid proposal and are used to determine the lowest bidder.  The total 
number of calendar days bid by the low bidder for the contract site (Site 00) becomes the 
contract time and the work item bid component becomes the contract total for contractor 
payment.   

Counties Enter up to four counties for each proposal (select from the list box).  Trns•port prints 
this information on some reports, but does not use it in processing.   

County Name The county name will be entered automatically after selecting the county 
number. 

County or Congressional District From the list box in the field, select the county to be 
added.  Once you select a county, the county number will be displayed and the county name will 
appear in the adjacent field.  Do this for each row of data. 

County/City/Congressional District Code A coded value indicating that the project or 
proposal includes work in a county, city, or congressional district.   

CSV (Comma Separated Value) A type of file where fields within a record are separated by 
commas.  Used to transfer data between systems.   

Current Work The current dollar amount of work the bidding vendor has outstanding.   
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Date and Time of Purchase The date and time a vendor purchases a set of plans for a 
particular proposal.   

Date of Addendum The date you add the addendum or the date it becomes effective.  Enter in 
MM/DD/YY format.   

Date of Estimate The date you complete an estimate.  Enter in YY/MM/DD format. 

Date of Letting The date you will hold a letting.  Enter in YY/MM/DD format. 

Date Priced The date you priced an estimate.  Enter in YY/MM/DD format. 

DBE Apply Interest  A percentage indicating the average number of times this item is selected 
for DBEs and the value of the item portion set-aside for. 

DBE Approval (Flag) Indicates the acceptability of the vendor to work on a contract.   

DBE Certification Date The date on which you certified the vendor for its business enterprise 
type.   

DBE Commitment Bidders state that if the Department of Transportation awards them a 
particular contract, they will use a particular qualified DBE vendor as a subcontractor or 
supplier.  Bidders also specify the value of work the DBE will perform.   

DBE Disadvantaged Owned Business Enterprise.   

DBE Goals A value selected from the attached DBENOTE code table, that indicates which of 
the two goals described above apply to this proposal.  If you choose NONE, Trns•port will not 
print goals on any report.  If you choose DBE, Trns•port will only print the DBE/MBE goal and 
will label it a DBE goal.  If you choose BOTH, Trns•port will print both the DBE/MBE goal 
(labeled as an MBE goal) and the WBE goal. 

DBE Interest Flag Not in use by the Department at this time.  Indicates whether an item is 
often of interest to or is selected for DBW/WBE set-aside.   

DBE Interest Percent to Apply A percentage indicating the average number of times this 
item is selected for DBEs and the value of the item portion set aside for DBEs.   

DBE/MBE Goal A percentage goal set for disadvantaged (DBE) or minority (MBE) business 
enterprises for a proposal.   

DBE/WBE Code A coded value (which must be in the DBETYPE code table) indicating 
whether the vendor is a DBE, WBE, or MBE.   

DBE/WBE Commitment A contract proposal might require that a percentage of a project be 
subcontracted to MBEs.  When the prime contractor submits plans to meet these requirements 
(that is, what work item(s) will be subcontracted to which subcontractors), enter and track these 
DBE/WBE commitments in Trns•port.   

DBE/WBE Vendor Number The vendor code for the particular DBE/WBE vendor, which 
must be in the VENDOR file.   

DBE/WBE Vendor Set a flag for any vendor in the Vendor file to indicate that the vendor is a 
DBE, a MBE, or a WBE for minority hiring.   
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Delete The lowest level of deleting.  Usually deletes one data record from one file, so you will 
only see one Delete Warning window.  (See also Power Delete and Strong Delete). 

Descending List order such that the first character of each successive list element has a symbol 
that occurs earlier in the alphabet or number system than the preceding element.  The list of 
numbers 40, 20, 10 and the list of codes Z44, C11, A25 are in descending order (see Ascending).   

Description Trns•port prints on most project reports.  These two lines of data allow you to 
enter a brief description (maximum 120 characters).  When Trns•port lists projects in a scroll 
window, it displays the first 28 characters of the project description with the PCN.  The first 28 
characters should therefore contain enough information to uniquely identify a project from all 
other projects. 

Designer The city, county, consultant, or squad that designed the project.  Selected from the 
STAFF code table. 

Detail Window Detail windows allow you to add, change, or browse information about a 
selected project, category, item, and so forth.   

Dialog Box A box displayed on the screen that allows you to input information.  It can contain 
text boxes, list boxes, command buttons, radio buttons, and check boxes.   

District The district where a project or contract is located.  Enter the managing district for the 
project, by clicking on the list box and selecting your district. 

Document Number If the state has an internal referencing number or library system for 
documents, this field would hold that number.  Trns•port does not use it in any Trns•port 
processing.   

Double-Clicking Pressing a mouse button twice in rapid succession.   

Dragging Using the mouse to highlight an area of the screen that is larger than one character.  
Point the mouse to the beginning of the area to highlight and click the left button.  Hold down the 
mouse button and drag the mouse until you have highlighted the desired area.   

E&C The percentage of engineering and contingency expenses for a construction project.   

Encumbrance Dedicating funds for a construction project.   

Engineer A code value (that must be in the STAFF code table) indicating the engineer in 
charge of the district, area office, residency or field office.   

Escrow Account A bank account set up by a vendor in which the Department will deposit the 
money normally retained by the Department.  The account will earn interest for the vendor, but 
the vendor cannot make withdrawals until the Department authorizes the bank to do so.   

Estimate Comments Textual comments or remarks about the estimate.   

Estimate Info The amount the contractor will receive for the estimated work performed on the 
contract during a pay period.  Trns•port bases the pay estimate on Item Progress and adjustments 
made for various reasons.  This entity also includes a breakdown of the payments.   

Estimate Numerous estimates are prepared over the life of a project.  Use Trns•port to produce 
these three: Preliminary Detail Estimate: Also referred to as the P, S & E Estimate, this report 
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provides a project view of costs, including add-on percentages and funding breakdowns.  
Proposal Estimate: Also referred to as the Design Estimate or Engineer's Estimate, this estimate 
contains a list of proposal items and the (estimated) costs.  Final Detail Estimate: Also referred 
to as the Contract Agreement Estimate.  This estimate uses the contractor's bid prices as the 
"estimate."  

Estimated Amount of Project The total estimated amount of work for a project.  The default 
is "0".  It is automatically filled by Trns•port PES each time the Preliminary Detailed Estimate 
process is run.   

Estimated Item Price The engineer's estimated unit price for an item.  Trns•port uses this field 
to determine an item’s cost for the Detailed Estimate.  Defaults to 0.000, but you can modify the 
value. 

Estimated Item Quantity The estimated quantity of work for an item.   

Estimated Price Lock Indicates whether you have finalized an estimated item price and it 
should therefore not be modified by users or the system.   

Estimated Price The Department's estimated cost for one unit of an item.  Trns•port uses this 
field to determine an item's cost for the Detailed Estimate.   

Estimated Quantity Used with Estimated Price to determine the cost of an item.  Used in 
Trns•port LAS to determine the value of bids, in Trns•port CAS to determine the authorized item 
quantity, and in Trns•port BAMS/DSS to analyze construction overruns.  Used with Estimated 
Price to determine the cost of an item.  Used in Trns•port LAS to determine the value of bids, in 
Trns•port SiteManager to determine the authorized item quantity, and in Trns•port BAMS/DSS 
to analyze contract overruns.  Defaults to 0.000, but you can modify the value. 

Estimated Unit Price The engineer’s estimated cost for one unit of an item.  Trns•port uses 
this field to determine an item’s cost for the Detailed Estimate.  Defaults to 0.000, but modify the 
value as necessary. 

Exempt from Retainage Not in use by the Department at this time.  Indicates whether 
Trns•port should withhold retainage for work performed on a specific item.   

Extended Amount from Proposal The bidder's extended price amount for a line item in the 
proposal and section and proposal totals.  Trns•port uses this field in production and Trns•port 
BAMS/DSS models use it.   

Extra A change to a contract to add additional work items.   

Federal Appropriation Codes A coded value indicating the type of federal appropriation.   

Federal Construction Class Describes the type of construction used for the category.  The 
Department can define its own codes and enter them in the FEDCCLS code table.  Trns•port uses 
this field to determine whether categories can be combined.  For Maintenance contracts, this 
field will always be “M”.  When you combine categories and Items in a proposal, Trns•port adds 
categories together if they have the same Federal Construction Class. 

Federal Funding Mark the check box if the fund contains federal dollars.  If you check the 
Federal Funding box, the funding source is a participating fund, which means that the federal 
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government is participating in funding these category Items.  If you do not check the box, the 
funding source is non-participating, which means that the funding is 100% state or a combination 
of state and local. 

Federal Participation Indicates whether a specific fund is a federal fund. 

Federal Work Category A coded value indicating the type of federal work performed in a 
category.   

Federal/State Project Number The federal or state project number identifying a project, 
proposal, or contract.  Enter N/A for all maintenance projects. 

FHWA The Federal Highway Administration.   

Field Book Not in use by the Department at this time.  If checked, this check box indicates that 
the project is maintained using a field book machine. 

File An entity that stores all information associated with one Trns•port project.   

Filter A way to quickly locate records in Client/Server Trns•port list windows.  You can specify 
search criteria to find a group of records.   

Final Detail Estimate Also referred to as the Contract Agreement Estimate.  This estimate uses the 
contractor’s bid prices as the “estimate.”  

Finance Code Letters that usually precede the control section.   

Fixed Price (Pre-Established Price) This indicates that the bidder is required to bid the 
price specified by the Department.  If you set this flag to "Y", the Estimated (or Revised) Price of 
the item will appear already filled in on bidders' proposal schedules.  The default value for this 
field is "N".   

Force Account An item of work the Department pays at the contractor's cost rather than at a 
bid price.  A force account includes the materials, labor and equipment the contractor actually 
uses to perform the work and might include state-specified allowances for overhead and profit.  
State-specified schedules usually determine labor and equipment costs rather than the 
contractor's actual payments.  You will typically use force account items when there is 
uncertainty about the work involved for the item and you cannot bid it knowledgeably.  
Examples include utilities relocation and toxic waste removal.  Because you pay the item at cost, 
the unit of measure is dollars.  Therefore, you often estimate force account items as if they were 
lump sum.  Because a force account is not a bid item, Trns•port does not pass it to Trns•port 
CAS or Trns•port BAMS/DSS.   

Fuel Adjustment Type A coded value indicating that an item might require a fuel price 
adjustment.   

Fund Assign funding sources at the project, category, and item level.  Typically, you specify 
funding sources at the category level; however, specify default funding at the project level and 
identify individual items as nonparticipating in category or project-level funding sources.  The 
funding defined for a category can consist of multiple sources with funding limitations and 
priorities established for each source.   

Fund Code A unique identifier for a funding source.   
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Fund Prefix An alternate name for a fund.   

Fund Priority Order A sequence number you use to indicate the order in which you should 
encumber funds when certain funds have limited participation.   

Funding Description A short description of the fund.   

Funding Exception Code A single item might belong in a particular category, except that it 
has a separate funding source from the other items in the category.  You could put that item in a 
separate category with its own funding splits, but Trns•port will allow you to put it in the same 
category with the other items and put the code of the fund that will pay for it in this field.   

Funding Group An identifier used to associate funds into groups.   

Funding Participation Limit The maximum amount, in dollars, that a fund will pay for this 
category.   

Funding Participation Percent The portion of work a particular fund will pay.   

Funding Prefix An alternate name for a fund.   

General Description/Comment A short description or written comment about the particular 
DBE/WBE vendor.   

Generics Extra fields Trns•port does not use in any processing.  These fields will only appear 
on reports that you have customized to include them.  If you use a generic field, you can redefine 
the field description (that is, the field label displayed on the window) to indicate the contents or 
use of the field.   

Highlight To shade an area to change its appearance.  Highlight with a mouse by pointing and 
clicking on the beginning of the area and dragging until you shade the desired area.   

Highway Number The identifier for the highway being worked on in a project.   

Highway Type A coded value indicating the type of highway (for example, asphalt, concrete, 
or dirt or two-lane or four-lane limited access).   

Historical Price The price that you have historically used for an item.   

Icon A symbol representing an application in the Microsoft Windows operating environment.  
Icons might or might not be active.  An icon’s name is the same as the application it represents.   

Increase/Decrease A modification of a regular/structure/sewer item's authorized quantity as 
specified by a recommendation.   

InspDailyRpt (Inspector's Daily Report) A written report generated every working day by 
an inspector that describes the work performed on a Contract monitored by that inspector.   

Invoice Number A unique identifier for a planholder invoice.   

Invoice Number A unique identifier for a planholder invoice.   

IRS Number The Federal Employer Identification (FEI) number assigned to the vendor by the 
IRS.  In some cases this will be a Social Security Number where the contractor is a small firm. 



Reference Manual for Production Projects & Proposals PES Release 5.9a                                         Page 106 of 133 

Item Alternate Code Different items can serve as alternates for each other, which means that a 
bidder can choose to bid on either item, but not both.  The first two characters of the item 
alternate code specify the alternate set and the third character indicates the choice within the set.   

Item Classification Function A coded value indicating the classification or category into 
which the item fits.  Used by Trns•port BAMS/DSS to group items into the same market share.  
Caution: When you assign an item classification to an item, be sure that the item has the same unit of 
measure or the same common unit of measure as the other items in the item class.   

Item Description A short description to be included on any Trns•port reports that include 
descriptions.   

Item Line Number A four-digit number Trns•port uses to identify the item.  Trns•port will 
automatically number the items for you with multiples of a user defined increment (for example, 
5, 10, 15 if by 5).  The increment is defined via an installation option.   

Item Material Information and factors linking a regular/structure/sewer item to the material that 
comprises the item.   

Item Number The Item Number from the Master Pay Item List.  It is contained in the 
ITEMLIST code table of Trns•port. 

Item Progress The quantity of a regular/structure/sewer item performed between successive 
measurements or estimates made by the Department inspectors or engineers.   

Item Summary A particular, quantified part of the work in a proposal.  If the work quantity is 
not measurable, Trns•port sets the quantity to 1.00 for the lump sum item.  An item summary 
contains the dollar value of all work in a proposal.   

Item The smallest unit of work identified within a project.  Items can represent biddable work or 
non-biddable work such as rights-of-way and force accounts.  You can define groups of items to 
represent alternate design possibilities and you can divide the quantity of work for an item across 
multiple categories within a project.   

Item Type A coded value indicating the type of material used for an item.   

Item Unit The unit of measure for an item.   

Item year Because Trns•port contains projects designed at different times, you may not change 
the reference information about each item (such as description and unit).  Doing so would change 
the meaning of projects already in progress.  Instead, create new reference item lists when 
necessary.  You may distinguish these lists by a spec year.   

Last Addendum Number The last addendum number used for a proposal. 

Last Description Number Filled in automatically by Trns•port when you enter long 
descriptions.   

Last Revision Date someone last revised the estimate.  Enter in YY/MM/DD format 

Latitude of Address The latitude on a map of the vendor's address.   

Latitude of Midpoint The default value is 650000, and may be changed as appropriate.  Enter 
latitude in the form degrees, minutes, seconds.   
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Letting Address A description of the letting location.   

Letting Call Order The order in which you will open a bid for a specified proposal during a 
bid letting.   

Letting Number A unique identifying number or alphanumeric for a letting.  It may be 
composed of any combination of eight numbers and letters.  For lettings in the districts, allocate 
two positions for the district number, two for the year, two for the month, and two for the date.  
This will be in the form of ##YYMMDD, where ## represents the district number.  If the 
occasion should arise that you will hold a second letting on the same date, you may insert a "B" 
in position seven.  The Central Office lettings commence with a prefix of CT.   

Letting Proposal Call Order The order in which you will open a bid for a specified proposal 
during a bid letting.   

Letting Status of Proposal A coded value indicating the status of a proposal.   

Lien/Claim A statement by an individual or company that they are owed a payment because of 
conditions caused by the contractor's work or performance.   

Liquidated Damages Per Day The amount to be charged, in whole dollars, for each day that 
a contractor exceeds the allowed time for a contract.  This has a default value of "1" and will not 
be used in preparing bidding documents.  Trns•port cannot handle the liquidated damages table 
contained in the Standard Specifications for Road and Bridge Construction. 

List Box Part of a dialog box that contains a list of choices.  Select one of the choices at a time.  
The list box will have a scroll bar to help you move through the list (see Radio Button and Check 
Box).   

List Window A list window contains a list of records relating to a particular process (for 
example, Projects).  From a list window, select a specific record and open a detail window that 
contains the fields and data associated with the record.   

Location of Bid Deposit The location at which bidders should deposit bids.   

Location of Letting The location at which bids will be opened.   

Location The site where work is being performed for the proposal.   

Long Description 2 A continuation of the long description of the item (maximum 60 
additional characters, if needed).   

Long Description A long description of the item (maximum 60 characters).   

Longitude of Address The longitude on a map of the vendor's address.   

Longitude of Midpoint The default value is 1650000, and may be changed as appropriate.  
Enter longitude in the form degrees, minutes, seconds.   

Low Cost Bid Item Flag Generated by Trns•port in the Bid Tab Edit process, this flag 
indicates whether the item is a low-cost item.  If the item has alternates or is an alternate, only 
one of the alternates will be flagged as the low-cost item.   
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Lump Sum Item Units A value, selected from the attached UNITS code table, that identifies 
the type of measurement used to determine the unit of one lump sum item. 

Maintenance Activity Number A value selected from the attached CWRKCLS code table 
that indicates the kind of work performed in the category.  This code value is also used with the 
Maintenance Management System (MMS). 

Major Item Flag Indicates that an item is important enough to appear on the Notice to 
Contractors, regardless of the dollar amounts allocated to it. 

Material Any measurable, physical substance used to perform an item of work or the substance 
of the completed item itself.   

Maximum Capacity The maximum amount of work, in dollars, that a vendor can perform.   

Maximum Contract Amount Paid A limit, expressed as a percentage of the original contract 
amount, for an automatically paid item.   

MBE Minority Owned Business Enterprise.   

Menu A list of related commands that you open and view.   

Minority Work Type Not used in Trns•port processing, this code is printed on some Trns•port 
reports.  Values entered here must be in the GRADING code table to be legal.  Each agency is 
free to specify the codes that are meaningful to it.   

Miscellaneous Item Non-standard items added to a project, which you identify as "7000" 
items.  Trns•port calls these non-standard items.   

Mouse Hand-held mechanical device used to position the cursor and perform actions on the 
screen.   

Non-Bid Item An item, such as a state-supplied item, that will be included in the project but 
will not appear on any bid documents.   

Non-Federal Participating Item An item in a construction project that is not eligible for 
federal funding.   

Non-Participating Fund Code Identifies a fund that will fund 100 percent of the work for a 
project item.  Trns•port will exclude the work for this item from funding for the category that 
contains the item.   

Notice Publication Date The date you will notify potential bidders of the letting of a 
proposal.   

Notice to Proceed Written notice to the contractor to proceed with the contract work and the 
contract beginning date.   

Number of Days Bid In a Cost Plus Time bid, the bid time number of days bid for the 
associated letting proposal’s awarded vendor for an associated proposal site.   

Number of Days The number of available or calendar days that are available for completion of 
a contract site.  Leave this field blank if you selected Completion Date for the Type of Days field 
above. 
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Number of Label Sets The number of sets of labels to be generated when you generate labels 
for this order.  You must fill in this field for Trns•port to generate labels.  Valid values are zero 
through nine.   

Number of Pages The number of pages of the special provision.   

Number of Plan Sheets The number of plan sheets purchased by a vendor.   

Number of Spans The number of spans of the structure represented by a category.   

Obsolete Flag Indicates whether the special provision is in effect or obsolete.   

Obsolete Item Flag Indicates that an item is obsolete and should no longer be used on new 
projects.   

Obsolete Vendor Indicates that a vendor is obsolete and therefore should no longer be used.   

Office Address The address of the district, area office, field office, or residency.   

Officer's Address Number The vendor address sequence number identifying the vendor 
officer's address.   

Ordered by The name of the person ordering the proposal plans.   

Originating Date of Specification The date a special provision is effective.   

OTSH One time shipping address.   

PS&E Plans, specifications, and estimates for a project.   

Part A collection of related portions of regular/structure/sewer items in a project.  In a typical 
project, The Department breaks down roadway items and bridge items into separate parts.   

Part Description The description you want to appear on the unit level funding summary report 
for this unit number.   

Part Number You can put whatever values you like in this field.  Unit numbers provide a way 
to group categories for reporting purposes on the Funding Summary and Funding Summary by 
Unit reports in the Detailed Estimate.  If no unit number is assigned, the unit number will appear 
as 000 on the Funding Summary report.  When assigning a unit number and project level 
funding, be sure to assign a unit number to all categories, not just the 0000 category (project-
level funds).   

Partial Payment Item Items for which work occurred during a voucher cycle paid according 
to quantity placed (excluding substandard work).   

Participation Limit The maximum amount in dollars that will be paid by a particular funding 
source.   

Participation Percent The portion of the work that will be paid by a particular funding 
source.    

Passed to CAS/DSS Indicates whether a contract has been passed to DSS (D), CAS (C), or 
both (B).   
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Password A code Trns•port uses to identify you in conjunction with your user name when you 
sign on to Trns•port.  You must keep your password secret to prevent other people from 
accessing your files without your knowledge.   

Pay Adjustment Adjustments applied to contract project payments.   

Pay Item Year Not now in use.  See Spec Year  

Pay Quantity The quantity of an item for which a specific estimate will pay.  It will usually be 
the sum of the item progress quantities performed since the previous estimate, but it might be 
different because the Department withholds payment for various reasons.   

Payment Fund A fund and dollar amount that you designate to pay for part of an estimate.   

Payment Voucher A record of what the payment should be to a contractor or escrow account 
for a particular project.  Trns•port generates this voucher for treasury and billings.   

Percent Complete Basis A coded value indicating the method used to determine the current 
percent of work complete.   

Percent Complete Threshold A percent of item completion that determines if an item 
should be paid automatically.   

Percent of Project Length If there is only one county involved in the project, enter 100 in the 
field.  If multiple counties are involved, enter percentages for each that will total 100%. 

Percent of Quantity Paid The percentage of the current item quantity to be paid to date at an 
automatic payment threshold.   

Percent Ownership The vendor's percentage of ownership of the affiliated company.   

PES Worksheet An interactive process that allows users to add items and item level data to 
projects quickly.  The functionality is provided through an interactive, spreadsheet-like data 
entry window.  Users are able to enter project item data from scratch, input data, or modify 
existing PES item data.   

Phone Number The phone number (including area code or extension) of the district, area 
office, field office, or residency.   

Phone The phone number (including area code or extension) of the district, area office, field 
office, or residency.   

Physical Road Number The name or number of the road where the project work is being 
performed.   

Planholder A vendor to whom you issue a proposal package that is valid to submit as a bid.  
Courtesy planholders purchase proposal packages on which they cannot bid.   

Plansheet A detailed description or graphic of a section of work performed in the project.  It 
can contain sketches, items, and quantities.   

Plansheet Item Quantity The recorded quantity of a work item at the plansheet level.  These 
quantities will be rolled up to the estimate item level.   
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Plansheet Item The portion of a regular/structure/sewer item assigned to a particular 
plansheet.   

Plansheet Number The number of the plansheet on which plansheet item and quantities are 
required.   

Plansheet Type A code table indicating the plansheet might be of a certain type or contain 
certain data (for example, roadway, bridge, structure or sewer).   

Pointing Moving the mouse until the tip of the arrow on the screen rests on a desired object.  
You can place the mouse on a flat surface and slide it to the object.   

Power Delete The second level of deleting.  Deletes multiple records from more than one file, 
so you will see two Delete Warning windows.  For example, if you are deleting a bid letting 
package, Power Delete will delete the letting call, bids, planholders, and proposal.  (See also 
Delete and Strong Delete)  

Pre-Established Price Indicates that the bidder is required to bid the price specified by the 
Department. 

Preliminary Detail Estimate Also referred to as the P, S & E Estimate, this report provides a 
project view of costs, including add-on percentages and funding breakdowns.   

Prequalification Certification Date The date you qualify the vendor to perform the type of 
work certified for the state.   

Prequalification Expiration Date The date the vendor's qualification for certification for 
work expires.   

Prequalification Update List Date The date you schedule to review the list of vendors who 
have pre-qualified.   

Previously Let As CONTID Indicates the contract ID under which a proposal was previously 
let.   

Price Index A coded value indicating that Trns•port should automatically adjust item prices for 
inflation according to the index.   

Price Lock Flag The default value for this field is "N".  There is a Trns*port PES process 
called Generate Bid Based Prices which may be used to fill in all the Estimated Prices.  That 
process uses historical bid data in the BAMS/DSS module to determine an estimated price for 
each item.  If you set this field to `Y', the Generate Bid Based Prices process will NOT compute 
a price for this item, leaving the manually entered price in place. 

Priced by Indicates the person from the attached STAFF code table who priced an estimate.   

Primary DBE/WBE Code A coded value indicating the vendor’s business enterprise 
certification type.   

Primary District The managing district. 

Prime Project Not used by the Department.  A prime project generally represents all work to 
be performed under a single federal project number.  This work is subdivided into Trns•port 
projects.  Each Trns•port project represents a logical portion of the prime project one project 
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might contain all bid items, another preliminary engineering and rights-of-way, and another non-
biddable construction work such as force accounts.   

Project Beginning Termini, Ending Termini, Beginning Station, Ending Station 
These fields let you define more precisely where the project work is taking place using notation 
defined by your agency.  Trns•port passes this data, which Trns•port prints on some reports, to 
Trns•port BAMS/DSS to pinpoint the project on maps.   

Project Control Number (PCN) A unique number or alphanumeric that identifies a project.   

Project Description Trns•port prints on most project reports.  These two lines of data allow 
you to enter a brief description (maximum 120 characters).  When Trns•port lists projects in a 
scroll window, it displays the first 28 characters of the project description with the PCN.  The 
first 28 characters should therefore contain enough information to uniquely identify a project 
from all other projects.   

Project Each Trns•port project represents costs associated with all or part of a construction 
project.  The information used to define a PROJECT generally comes from The Department's 
Program Planning and Design branches.   

Project Grade Not used in Trns•port processing.  Trns•port prints this code on some Trns•port 
reports.  Values entered here must be in the GRADING code table to be legal.  Each agency can 
specify codes that are meaningful to the agency.   

Project Item Line Number A unique sequential identifier for an item within a project.  This is 
a four digit number Trns•port uses to identify the item.  Trns•port will automatically enter this 
value when you run certain processes.  When an addendum is being created, you identify an item 
to be changed by choosing a value from the attached drop down list.  When you select a category 
number, Trns•port fills in the Project item Line Number list with all project item line numbers 
for the selected project and category. 

Project Item See Item.   

Project Item Sequence Number A unique sequential identifier for an item within a project.   

Project Location The location of the primary work performed in the project.   

Project Number Enter the Financial Project (FINPROJ) Number. 

Project Road Name The name of the primary road on which project work is being performed.   

Project Sequence Number A sequential number for each event entered.   

Project Type     A value, selected from the attached PROJTYP table.  The Department 
specifies its own values for the PROJTYP table.  Leave this field blank for Maintenance projects. 

Project Work Type A value, selected from the attached PWRKTYP table.  The Department 
specifies its own values for the PWRKTYP table.  Enter a value in the Project Work Type field 
to run this project through the Bid-Based Prices processes.  Project Work Type is one parameter 
used to determine the bid-based price.  Leave this field blank for Maintenance projects 

Proposal Addendum Number A sequential number identifying a proposal addendum.  
Trns•port enters a sequential value automatically. 
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Proposal Bid Total The total cost of the proposal as determined by the bidder.   

Proposal Call Order The order in which you will open a bid for a specified proposal.   

Proposal Class For maintenance projects enter "I" from the list box. 

Proposal DBE Goals A code (which must be in the DBENOTE: code table) indicating which 
of the two goals described above apply to this proposal.  If you enter NONE, Trns•port will not 
print goals on any report.  If you enter DBE, Trns•port will only print the DBE/MBE goal and 
label it a DBE goal.  If you enter BOTH, Trns•port will print both the DBE/MBE goal (labeled 
as an MBE goal) and the WBE goal.   

Proposal Estimate Also referred to as the Design Estimate or Engineer’s Estimate, this 
estimate contains a list of proposal items and the (estimated) costs.   

Proposal Fund Type A coded value indicating the kind of funding used for the proposal.   

Proposal Item Each proposal section is a collection of one or more proposal items.  Each 
proposal item is a bid item.  Trns•port constructs proposal items from one or more project items 
by combining items with the same item code from the same section.  You can override this 
"folding" of similar project items.  Similar project items will create separate proposal bid items.   

Proposal Line Number A unique sequential number that identifies a line item within a 
proposal.   

Proposal Location The site where work is being performed for the proposal. 

Proposal Notes Available for special notes that need to be communicated to bidders.  Limited 
to 60 characters. 

Proposal Number Held If the state has a serial sequence number or a numbering system for 
proposals, this field would hold that number.  Trns•port does not use it in any Trns•port 
processing.   

Proposal Schedule A listing of contract items in the proposal form that show quantities and 
units of measurement and have blank spaces for bid price insertion.   

Proposal Section Number A unique sequential identifier for a proposal section.   

Proposal Section Represents a grouping of proposal items.  Trns•port creates sections by 
grouping all categories with the same work class on all projects assigned to the proposal.  You 
can override this "folding" of similar categories into single sections.  Then similar project 
categories will create separate proposal sections.  Trns•port will always assign project categories 
representing different alternates to different proposal sections.  The description field will be the 
description of the lowest MA number in the project.  This description should be changed to 
reflect the overall project. 

Proposal The entities presented to potential contractors for bidding.  You construct a proposal 
from Trns•port projects.  Typically, you combine multiple projects into a single proposal.  (You 
cannot add an individual project to more than one proposal or split it among multiple proposals.)  
Proposal information generally includes contract time specifications, DBE/WBE goals, bonding 
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information, a detailed description of the work the contractor will perform, and an identification 
of any necessary special provisions, supplemental specifications, or both.   

Proposal Type A coded value indicating the location of the proposed letting.  DIST or CENT.   

Proposed Letting Date This field is entered from the FM system.  If the date is in error, see 
the Work Program office to have it corrected. 

Qualification Amount The total dollar value of contracts for which the vendor is qualified to 
work.   

Qualification Classes A classification of work for which a vendor is qualified.   

Quantity of Complete Plans The number of complete plans purchased by a vendor.   

Quantity of Complete Plans without Cross-X The number of complete plans without 
cross-references purchased by a vendor.   

Quantity of Proposals The number of proposals purchased by a given vendor.   

Radio Button Part of a dialog box that allows you to select one option from a group of related 
options.  Each choice has a circular button (see List Box and Check Box).   

Reason for Non- Processing A coded value indicating the reason Trns•port did not process 
a proposal.   

Recommendation Modification of contract items, such as extending the authorized time, 
changing an item quantity, or adding a new item to a project.   

Regression Inclusion Not currently in use.   

Regular/Structure/Sewer Item A particular, quantified part of the work in a project (if the 
work quantity is not measurable, Trns•port sets the quantity to 1.00 for the lump sum item).  
Regular/structure/sewer item contains the dollar value of all work in a project.  This entity 
includes regular items, structure and bridge items, and sewer items.   

Relation to Vendor A coded value indicating the relationship between a vendor and its 
affiliate.   

Retainage The amount withheld from voucher payments made to a contractor pending 
completion of a contract.   

Revised by A coded value indicating the person who revised an estimate.   

Revised Item Price A revised price for an estimate item.  If you enter a value, Trns•port will 
use it instead of the original engineer’s estimated item price.   

Revised Price Change the Estimated Price by filling in a new value in this field.  Trns•port 
will use the Revised Price instead of the Estimated Price whenever this field is non-blank, which 
allows you to keep a record of the changes you have made to any of the estimated prices.   

Road Name The name of the primary road associated with the prime project.   

Road Section Number An identifier for the road section in which construction is taking 
place.   
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Road Section Number, Beginning Termini, Ending Termini, Beginning Station, 
Ending Station Identifiers for the road section in which construction is taking place.   

Road System A coded value indicating the road system of which this highway is a part (for 
example, interstate or federal, state or county highway).   

Road User Cost Per Day A value used in determining the low bidder in a Cost Plus Time 
bid.  A value can only be entered in this field if the value in the Type of Days field is CD or AD.  
A non-blank value in this field indicates the Site is a Cost Plus Time Site.  The value is the cost 
per day of the inconvenience of the construction.   

Route Number The route number of the road affected by a project.   

Route The route number of the road affected by the project.   

Sales Tax Code A coded value indicating the sales tax that applies to the vendor.  The 
Department does not collect sales tax. 

Scroll Bar A rectangular box in list boxes or windows.  The bar contains up and down scroll 
arrows or left and right scroll arrows and a scroll box.  The scroll bar allows mouse users to 
move through text to view sections that are not currently visible.  To scroll, click and drag the 
scroll box or click the scroll arrows.   

Scrolling Move the cursor left or right or up or down to see parts of the text that are not 
currently visible (see Scroll Bar).   

Section Assignment Flag telling Trns•port to assign project categories to proposal sections 
automatically or do it manually by entering section numbers in the category records.  The default 
value is Y, which means Trns•port will automatically assign categories to sections.   

Section Description A short description of the proposal section.   

Section Number See Proposal Section Number.   

Section See Proposal Section Number.   

Securities Account A contractor can establish an escrow account with the Department so that 
the Department can hold securities in place of retainage.   

Securities in Lieu of Retainage Not in use by the Department at this time.  A flag indicating 
whether you will allow the contractor to deposit securities with the agency to reduce the amount 
of retainage withheld in payment vouchers.   

Set Aside Proposal A value, selected from the attached SETASID code table that indicates 
you have set aside a proposal for a particular purpose.  Leave blank, this is not presently in use. 

SHA State Highway Agency.   

Ship-to Address Number The vendor address sequence number of a planholder's shipping 
address.   

Short Description A short description of the item (maximum 40 characters).  When Trns•port 
lists items on a scroll window, Trns•port displays the first 30 characters of the item short 
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description beside the item number.  The first 30 characters should therefore contain enough 
information to uniquely distinguish an item from all other items.   

Site Number A unique identifying sequence number for each site.  Each contract must have a 
site 00, which represents the contract as a whole, in addition to any other sites.   

Site Proposal sites represent work locations for which time charges are accrued.  The default 
situation is for a single site of time charges to accrue on the contract as a whole.  If contractors 
will construct several project entities (for example, bridges) as part of a single contract, you can 
treat each project entity as a separate site to assign completion time and assess liquidated 
damages.   

Social Security Number The social security number of the vendor officer.   

Source of Price A value, selected from the attached PRICSPR code table, that indicates the 
originating source of an estimated price for an item (e.g., estimated or historical).  Defaults to 
“E” for estimated.  You can indicate in the Source of Price field how Trns•port determined the 
estimated or revised price.  Trns•port sets it to E, but you can change it.  This field identifies 
where the estimated price came from, but does not apply to the revised price, and the source of 
price field can contain an “E” for the engineer estimated the cost, “GBBA” for a bid-based 
average, “GBBR” for a bid-based regression, or “H” for a historical price. 

Spec Bk Year Not now in use. 

Spec Book The general rules covering acceptable work and practices for contracts with an 
SHA.   

Spec Year A default value of 04 has been set.  Because Trns•port contains projects designed at 
different times, you cannot change the reference information about each item (such as 
description and unit).  Doing so would change the meaning of projects already in progress.  
Instead, you can create entirely new reference item lists when necessary.  You can distinguish 
these lists by a specification year.  This field identifies the specification year item list used on the 
project.  Spec Year 07 is now being created. 

Special Provision An addition or revision to the standard and supplemental specifications 
covering conditions peculiar to an individual project.   

Special Provision Code A unique identifier for a special provision.  Not in use by the 
Department. 

Special Provision Description A short description of the special provision.  Not in use by 
the Department. 

Special Provision Text File Name A field that identifies the library member of which the 
special provision is a part.  Not in use by the Department. 

Special Provision Type A coded value indicating the type of special provision.  Not in use by 
the Department. 

Special Provisions An addition or revision to the standard and supplemental specifications 
covering conditions specific to an individual project.  This feature is not now in use by the 
Department.  Flag used to tell Trns•port if you will assign special provisions to this proposal that 
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are print with the proposal schedule.  The default value is N (you have assigned no special 
provisions). 

Special Start Date Available to indicate to bidders cases where a special start date will be 
established. 

Specialty Item Flag Indicates whether an item is a specialty item.   

Specification Number A classification number for types of construction items as used in the 
Specification Book.   

Specification Year Because Trns•port contains projects designed at different times, you 
cannot change the reference information about each item (such as description and unit).  Doing 
so would change the meaning of projects already in progress.  Instead, you can create entirely 
new reference item lists when necessary.   

Specified Completion Date The projected date when the contractor will complete work for a 
given site.  Maintenance Contracts should indicate the contract completion date in this field, for 
example June 30, 2005. 

Specified Start Date The project date when the contractor will start work on a given site.  
Maintenance Contracts should indicate the contract start date in this field, for example July 1, 
2004. 

State Mat Flag (State Furnished) The default value for this field is "N".  You may have a 
few non-biddable items that by all logic seem to belong grouped together with the biddable 
items.  You could create an artificial, non-biddable project for those items, but Trns•port allows 
you to enter them in the logical place, and flag them by placing a `Y' in this field.  Non-Bid items 
will not appear in any bid documents, and will not be passed to SiteManager.  A common use 
for this field is to identify FHP use on a project. 

State of Incorporation A coded value indicating the state in which the vendor company is 
incorporated.   

State, Zip The two-letter state code and zip code for the address.   

Status A value (which must appear in the PRJSTAT code table) used to indicate the status of a 
project (for example, in design or ready to let) or left blank.  Trns•port includes this field on 
some reports, but does not use it elsewhere.   

Status Date The date you entered the status.   

Status of Bid A coded value indicating the status of the vendor's bid.   

Status of Letting A coded value indicating the status of the letting (for example, planned, 
scheduled, or postponed).   

Stockpile A quantified amount of a material delivered to the contract site for use in a specific 
item.   

Stockpile Change Adding new material to a stockpile or removing material already in the 
stockpile for placement in a regular/structure/sewer item.   
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Strong Delete The third level of deleting.  Deletes multiple records from more than one file, so 
you should see three Delete Warning windows.  For example, if you are deleting a bid-letting 
package, Strong Delete will delete the letting call, bids, planholders, the proposal and the 
projects, items and funds (the whole tree of data).  (See also Delete and Power Delete)  

Structure Work Class Used by the Work Class percentage report to classify proposals into 
bidding pre-qualification areas.  Select a value from the attached CFEDWCLS code table.   

Structure Work Type Similar to the Federal Work Category except that the FEDSUPP Code 
Table is used.   

Subcontract A subcontract in Trns•port describes the contract work that the prime contractor 
will not perform.  You may divide subcontracts into items and define subcontracted quantities.  
Each subcontract item can have a partial item percentage applied to it, which indicates that the 
subcontractor will perform only part of the item work.   

Subcontractor An individual, firm or corporation to which the contractor sublets part of the 
contract.   

Subcontractor An individual, firm, or corporation to which the contractor sublets part of the 
contract.   

Subcontractor Payment Money paid by the contractor who holds a contract with the 
Department to a vendor that might be the subject of a DBE commitment for the contract.   

Supplemental Agreement A written agreement between the contracting authority and the 
contractor that you execute on the prescribed form and get approved as required by law.  The 
supplemental agreement covers extra work, alterations, or adjustments as provided for within the 
scope of the contract.  The extra work or change order constitutes a modification of the contract 
as originally executed and approved.   

Supplemental Description 2 An additional 40 characters used for item descriptions.   

Supplemental Description Used only for miscellaneous items.  Not in use by the Department 
at this time. 

Supplemental Item year Can be used by the agency to denote a supplemental item year in 
addition to the primary item year.  Trns•port does not use this field in any processing  

Supplemental Proposal Description Additional project-specific descriptive information for 
a project item.   

Supplemental Specification Year This field was in use into 2005, but is not now in use.  

Supplementary Work Code Similar to the Federal Work Category except that Trns•port uses 
the FEDSUPP code table.  A coded value indicating the type of federal work performed in a 
category.   

Supplier Only Flag Indicates that a vendor might be a supplier of materials only.   

Surety Agent ID Trns•port treats surety agents as vendors for information storage.  This field 
holds the vendor code of the surety agent for this bid.  The value entered here must appear in the 
VENDOR file.   
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Surety Company ID Trns•port treats surety companies as vendors for storing information in 
Trns•port.  This field holds the vendor code of the surety company for this bid.  The value 
entered here must appear in the VENDOR file.   

Text Box A dialog box component that accepts input you type in or copy from another file.   

Time Charge Number of days worked on a particular site.  Used to track contractor work time 
and assess liquidated damages, if necessary.   

Time Extension A modification (usually an increase) in the time a contractor can work on a 
contract without incurring a penalty.   

Time Method See Type of Days.   

Time of Letting The time a letting will be held.   

Title of Officer The title of a vendor officer.   

Trns•port AASHTO's information system for managing transportation programs.  A 
computerized system through which a SHA can manage construction projects.  Modules include 
Trns•port CES, Trns•port PES, Trns•port LAS, Trns•port CAS, and Trns•port BAMS/DSS.   

Type of Action The type of action (add, change or delete) to be performed by an addendum 
item.   

Type of Bid Received A coded value indicating the type of bid.   

Type of Corporation A coded value indicating the type of business structure used by a 
vendor.   

Type of Days A coded value indicating whether Trns•port should base contract time on 
available working days, calendar days, or a completion date.  Maintenance contracts should 
indicate Completion Date in this field. 

Type of Item (Materials) A coded value (which must appear in the ITEMTYP code table) 
identifying the material type of the item.   

Type of Line Indicates whether the proposal line is at the item (L), section (S), or proposal (P) 
level.   

Type of Road This field is entered from the FM system.  If it is in error, see the Work Program 
office to have it corrected. 

Type of Vendor A coded value indicating the type of vendor.   

Type of Vendor Certification A coded value indicating the type of work a vendor is 
authorized to perform.   

Type of Work Classification A coded value (which must appear in the VWRKCLS code 
table) indicating the classification of work the vendor is qualified to perform.   

Uncompleted Work The amount of work, in dollars, a vendor has outstanding.   
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Unit Bid Price The bidder's unit price for a line item in the proposal.  Trns•port requires this 
field if the Type of Line is L at the item level.  Trns•port uses this field in production and 
Trns•port BAMS/DSS models use it.   

Unit Description The description to appear on the unit-level funding summary report for a 
given unit number.   

Unit Number A unique identifier for a unit.  You may put whatever values you like in this 
field.  Unit numbers provide a way to group categories for reporting purposes on the Funding 
Summary and Funding Summary by Unit reports in the Detailed Estimate.  If you do not assign a 
unit number, the unit number will appear as 000 on the Funding Summary report.  When you 
assign a unit number and project-level funding, be sure to assign a unit number to all categories, 
not just the 0000 category (project-level funds).  Not in use at this time.  The default value is 
000.  Do not change this value. 

Unit of Measure A coded value (which must appear in the UNITS code table) indicating the 
type of measurement used to determine one unit for lump sum items.   

Unit See Unit of Measure.   

Unit System This field indicates whether a project will contain items designated as English 
(E), metric (M), or neither (N).   

Units for Lump Sum Items A coded value indicating the type of measure for the item 
associated with the adjustment index.   

Urban/Rural Class A value selected from the URBRUR code table that indicates whether the 
project classification is rural or urban. 

User Name The name by which Trns•port knows you.   

User Permission A user's right to view and edit the information in a project file.  Each file can 
have one or more people listed as users for that file.  User permission differs from owner 
permission in that someone with user permission cannot view or edit the project user list for the 
file.   

Valid for Bidding Flag Indicates whether a planholder purchased a valid-for-bidding proposal.   

Vendor Address The vendor's address.   

Vendor City The vendor's city.   

Vendor Name (Long) The vendor name (long description).   

Vendor Name (Short) The vendor name (short description).   

Vendor Number A unique identifier for a vendor.   

Vendor Officer The name of an officer for a vendor.   

Vendor Phone Number The vendor's phone number.   

Vendor State The vendor's state address.   
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Vendor Trns•port uses the Vendor file to maintain information about contractors, 
subcontractors, suppliers, surety companies, surety agents, and escrow agents.  You can also use 
it to store information about counties (or other municipalities) and utilities that perform relevant 
work.  Trns•port uses information about these vendors, their affiliations, officers, addresses, and 
facilities in numerous Trns•port processes.   

Vendor ZIP Code The vendor's zip code.   

Viewer Permission A user's right to look at the information in a project file.  Each file has one 
or more people listed as viewers for that file.  Trns•port automatically allows whoever creates a 
file to look at the file because Trns•port gives that person owner permission.  The owner of a file 
can also give other users viewer permission for that file.   

Voucher A Trns•port voucher describes a contractor progress payment for a specific project.  
Trns•port computes voucher information automatically and accounts for partial item quantities 
performed, material allowances, retainage and liquidated damages.  You can make other 
payment adjustments manually to cover unusual circumstances.  Trns•port maintains a complete 
audit trail of all voucher related information, which allows Trns•port to regenerate previously 
paid vouchers for review.   

WBE Goal (PCT) A percentage amount indicating the goal that has been set for women 
business enterprises for the proposal. 

WBE Goal The dollar amount the prime contractor has actually paid to date to WBE 
subcontractors and suppliers.   

WBE Woman Owned Business Enterprise.   

Wild Card A character that can substitute for other characters.  You can use a * or ? in the Filter 
window's Value field with the Like operator.   

Work Mix This field is entered from the FM system.  If it is in error, see the Work Program 
office to have it corrected. 

Work Type Code A coded value indicating the type of work a vendor is qualified to perform.    

Zone An artificial separation of the state for material and labor pricing.  Zones can be drawn 
without regard to county or other pre-existing logical subdivisions of a state.   
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Appendix B Control Group 

The assignment of Access Control Groups is one of the principal tools available to the 
Department to control access to project data.  Through the plan outlined here, a hierarchy can be 
established where data may be compartmentalized to restrict access to a set of people who need 
visibility of a particular project and to deny visibility to those who don’t. 

The use of Control Groups satisfies two concerns.  The first is to reduce the volume of 
information that will appear on Project List screens, and second to secure information during the 
bidding and award process.  The use of Control Groups allows the visibility projects to be moved 
from one person to another.  An example would be a project in District 2 that might have a 
Control Group of CD02PMA.  With this Control Group assigned to the project, the District 
Estimator(s), having a personal Access Control Group of CD02*, would always have visibility of 
the project.  Similarly, any person having an Access Control Group that is less restrictive would 
also be able to see the project on his or her project list screen.  For example, a user with an 
Access Control Group of C* would have access to every project in the Production organization 
statewide. 

For the management of projects for Central Office letting, the sequence of Control Groups 
assigned to the Project, and the Proposal header when it is created, would be as follows: 

 CD02PMA: When under the control of a District Project Manager. 

 CD02: When control of the project shifts from the Project Manager to the District Estimator. 

 CC02: When the District Estimator transfers the proposal to the Central Office for letting.  A 
further refinement here will be decisions in the Central Office Estimates Office about 
compartmentalizing within itself.  For example, a particular estimator may use CC02TW 
(initials) to assign the access to another estimator, or CC02A to have proposals shared by two 
or more Estimators as a group within the overall estimates office. 

 CT02: When the proposal is ready for processing by the Central Contracts Administration 
Office.  It is necessary that the proposal Control Group remain unchanged while the project is 
in LAS and the Contracts Administration Office in order to ensure that the Engineer’s 
estimate is always under the control of only the estimator. 

The following table illustrates how visibility of projects to a community (Maintenance or 
Production) for oversight is granted, and then to a smaller group of project or maintenance staff 
for the control and management of project detail. 
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         PES  LAS 

District Contracts Manager      ?L##*  ?L##* 

District Contracts Assistant A      ?L##A* ?L##A* 

District Contracts Assistant B      ?L##B* ?L##B* 

 

District Production Director      CD##PM* None 

District Production Project Manager A    CD##PMA* None 

District Production Project Manager B    CD##PMB* None 

District Project designed by Consultant Firm    CD##T### None 

 

District Estimator       CD##*  CD##* 

Assistant District Estimator      CD##A* CD##A* 

 

District Maintenance Engineer     MD##* None 

Assistant District Maintenance Engineer A    MD##A* None 

District Maintenance Contract Estimator    MD##* MD##* 

Assistant District Maintenance Contract Estimator   MD##A* MD##A* 

 

District Work Program Manager     ?D##*  None 

Central Maintenance Manager     M*  None 

Central Estimator       CC*  CC* 

Central Office Production Manager     CC*  None 

Central Office Contracts Manager     CT*  CT* 

 

Control Group Structure: 

Character position 1:  M = Maintenance Project 

C = Construction Project 

Other characters may be assigned if desired to segment project development to other specialty 
areas. 
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Character position 2:  D = District Office processing 

C = Central Office processing 

T = Central Contracts Administration Office 

L = District Contracts Administration Office 

 

Character positions 3 & 4: District Number 

Character position 5: The letters T, U, V, W, X, Y, and Z are reserved for Central Office and 
statewide use.  When a consultant firm is the designer of a project, the last 
four characters of the control group will identify the consultant firm.  The 
letters T, U, V, W, X, and Y identify consultant firms. 

A project created in the Central Office could be assigned an office code. 

Character positions 6/7/8: Organizational or subordinate breakout where desired.  For 
consultant firms, these three characters, in conjunction with a letter 
in character position 5, identify the firm. 

 

The Control Group feature is a very important tool, but it has limitations: 

 It is not a code table and, therefore, will require a thorough understanding of the structure by 
Application Managers and Security Coordinators. 

 Control Group is not available to Letting Headers. 

 When transferring a project or proposal to another user, take car to ensure that all letters in 
the new Control Group are capitalized, and that a valid Control Group has been used.  If 
these precautions are not taken, a project or proposal will be removed from the project or 
proposal list screen of the previous user and will be available to no one.  Under this 
circumstance, a user with high-level authority such as a Security Coordinator or Application 
Manager will have to find the errant project or proposal and assign a valid Control Group. 
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Control Group Life Cycle 

A Control Group assigned to a project/proposal might evolve in the following manner: 

Maintenance Contract 

 Receive Maintenance Project from FM MD## 

 District reassigns project internally  MD##A (or other subset) 

 Create Proposal Header   MD##A 

 Pass to Contracts office   ML## 

 Contracts Administration Office activity ML## (or subset if desired) 

 Pass to "estimator" for Bid Analysis  MD## (or other person) 

 Return record to Contracts office  ML## 

 Complete award and execute phases  ML## 

 

Construction Project 

 Receive Production Project from FM  CD## 

 District reassigns project internally  CD##A (or other subset) 

   Or 

 District reassigns to consultant firm  CD##T365 (or other subset) 

 Pass file to District Estimator   CD## 

 Create Proposal Header   CD## 

 Pass to District Contracts office  CL## 

 Contracts Administration Office activity CL## (or subset if desired) 

 Pass to Distr Estimator for Bid Analysis CD## 

 Return record to Contracts office  CL## 

 Complete award and execute phases  CL## 

  Or for Class 1 Contract 

 Pass file to District Estimator   CD## 

 Create Proposal Header & Price Job  CD## 

 Pass to Central Estimator   CC## 

 Pass to Central Contracts Admin. Office CT## (or subset if desired) 

 Pass to Central Estimator for Bid Analysis CC## 

 Return record to Contracts office  CT## 

 Complete award and execute phases  CT## 
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Appendix C Filtering and Sorting 

The Trns•port Filter 

A filter provides the user with a means to limit the list of records appearing in a window.  The 
Filter Function is available on most LAS and PES screens.  It is especially helpful in limiting an 
item List.  Use the filter to enter selection criteria on one or more fields applicable to the active 
window.   

PES and LAS are set up to support both upper and lower case characters.  Fields that are 
populated from the Department mainframe will be in uppercase because the mainframe stores 
everything in uppercase.  For instance, the Item Description is in uppercase, so when filtering on 
the Short Description field, look for all uppercase characters.  All code values are stored in 
uppercase.  When filtering on a code-based field, search for uppercase letters.  Other fields, such 
as the second line of the Location field on the Project Header record, can have both upper and 
lower case letters in them.  Be 
aware of the case of a field 
when performing a filter. 

To use the Trns•port filter: 

• Click the icon that looks 
like a funnel.  

 

 

 

 

 

 

 

 

• This screen will appear.   

 

 

The list box labeled Column will list all of the fields that are available for the search.  The 
Operator list box contains the relationships that are available between the field that chosen in the 
Column list box and the entry in the Value box.  The Value contains a literal that is being 
compared to the field in the Column box.   

 

Click the Column, Operator, and Value fields to display lists of values from which to choose the 
information to be filtered. 
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Column  The Column field contains the names of the most commonly used columns 
in the table from which the list window is built.  When you click the down 
arrow in the column field, the list of columns to choose from will appear.  
Select the column you desire. 

Operator  The Operator field contains the operators equal to (=), greater than (>), less 
than (<), greater than or equal to (>=), less than or equal to (<=), not equal 
to (<>), and Contains and Does Not (contain) to narrow the filter.  Select 
the operator you desire. 

Value The information you type in the Value field is the filter criterion to match. 

 

This illustrates a filter on the Projects List 
window, set to select on the Federal/State 
Project Number column, with the operator 
selected as =, and the Value set for N/A.  
This value will select Maintenance 
projects in this example. 

The resulting Projects List 
window appears. 

If the selection results in a 
blank window, click the Filter 
button again, and then click 
Show All.  This will restore the 
complete window list, and try 
again with different criteria in 
the operator field or a different 
value. 

 

 

The Advanced Filter 

You may also filter information using a 
more complex set of criteria.  Click the 
Advanced button and Trns•port displays 
the Advanced Filter window.  This 
window allows you to use multiple 
combinations of conditions to filter with 
various operators, values, and logical 
combinations. 

Use the Advanced Filter window to build 
a set of conditions for Trns•port to use to 
filter information.  This set of conditions 
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consists of a series of “where conditions” combined with logical options, such as And/Or, (+ and 
(–.  Create each where condition by choosing a value in each of the Column, Operator, and Value 
fields and then clicking the ACCEPT button. 

Column The Column field contains the names of all the columns in the table from which 
the list window is built.  When you click the down arrow in the column field, the 
list of columns to choose from will appear. 

Operator The Operator field contains all the operators found in the basic filter plus Like and 
Not Like, operators used for pattern matching. 

Value  The information you type in the Value field is the filter criterion you are using as 
a delimiter or are trying to match. 

Use "*" as a wild card to match any value or "?" to match a single character only with the LIKE 
or NOT LIKE operators.  To search for a value that contains the characters "*" or "?", use the 
backslash character (\) just before the "*" or "?".  For example, Quantity \* item would search for 
Quantity * item.  To search for the "\" character, put a backslash in front of the "\"; for example, 
use \\job to search for \job. 

Trns•port displays each where condition in the Select Where area of the Advanced Filter window 
in the order in which you create them.  After all of the where conditions you need for the filter 
are listed, combine them into a “where clause” by clicking in the And/Or column to the right of 
each condition line and selecting the appropriate option from the menu for each line.  Typically, 
all lines requiring Or should be combined before the lines requiring And. Use the logical options 
(+ and (– to override the And/Or combinations where necessary. 

To add the first row: 

• Click or enter values for the Column, Operator, and Value fields at the top of the 
screen. 

• Click the Accept button.   

To add another row,  

• Click the Add Row button,  

• Click the row just added.   

• Click or enter values in the 
Column, Operator, and Values 
fields. 

• Click the Accept button. 

Add parenthesis as needed and choose 
either And or Or as appropriate.   
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To save a filter: 

• Enter a name in the Name field. 

• Click the Save button.  

The filter will be available for future use.   

 

This example is Bid Letting 
Number; Contains; CT?.  
This filter is named CT 
Lettings.   

• Click the SAVE button to 
save the filter.   

• Click APPLY 

The results of this advanced 
filter appear.   

 

Reuse a filter. 

This and other advanced filters may be re-used by:  

• Click the Filter Icon. 

• Click the ADVANCED button. 

• Click the down arrow in the Name field. 

• Click the name of the filter. 

• Click APPLY.   

To build a filter that selects on 
Maintenance Projects in District 3, follow 
these steps: 

• Create the first where condition by 
selecting values in each field 

• Click the ACCEPT button.   
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The information will be moved to the 
lower section as row one, and you may 
select And/Or.  In this case select And. 

 

• Click the ADD ROW button. 

• Highlight the new row.   

This makes the Build Where Condition 
window active for the new row. 

 

 

• Create the second where condition 
as shown here. 

• Click the ACCEPT button. 

Name the filter you have built.  In this 
example, the name given is D3 
Maintenance.  The name can be up to 30 
characters long.  Now that the filter is 
complete, click the SAVE button to save 
this filter so that you may reuse it in the 
future. 

 

Click the APPLY button to see 
the results of this two-condition 
filter on the Projects List 
window, where it was built.   

If the filter doesn’t work the 
first time, reopen the advanced 
filter, click the name window to 
select and reopen the filter, and 
adjust condition statements that 
may be causing the problem.  
You may always restore a full 
list by clicking on Show All at 
the regular filter. 

To use the filter again, select 
the filter name from the list box.  

To remove the saved filter from the database, Click DELETE.  
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Sorting Information 

To sort information in a list window, click the 
Sort button.  It is located to the right of the Filter 
button.  Trns•port displays the Sort window. 

The Column field contains the names of all 
columns in the table that are used to build the list 
window.  When you click the down arrow in the 
column field, the list of columns to choose from 
will appear. 

Click Asc or Desc to select an ascending (A-Z) or descending (Z-A) sort order for the selected 
column.  When values containing both numbers and letters are listed in ascending order, numbers 
precede letters, and vice-versa for descending order. 

In this example,  

• Click the Federal/State Project Number. 

• Click APPLY.  

If you Click CANCEL, Trns•port returns to the 
list window without sorting the list window. 

 

Trns•port sorts the rows in the order you 
specified.  The results may be seen here. 

Note that as in the Advanced Filter 
functions, the Sort functions may also be 
made complex.  You may sort on different 
fields and establishing a sort order.  You 
may add sort criteria by clicking the ADD 
button to add a row, and so forth. 

If you Click INSERT, Trns•port inserts 
another row for sort criteria before the 
currently selected row.  If you Click 
DELETE, Trns•port deletes the currently 
selected row of sort criteria. 

If you Click HELP, Trns•port displays a help window with information about sorting a list 
window. 

One difference with Sort is that it must be set up each time you wish to use it.  There is no 
naming or saving feature associated with it. 
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Appendix D Printing and Saving with Citrix MetaFrame 

Use of the Citrix MetaFrame 
server, requires certain setup 
for you to save the reports to 
the PC and for printing them to 
the network printer. 

To set up access to the PC, 
Login to any Trns•port 
application.  Access the task 
bar on the PC.  As seen at the 
right.  

• Click the "ICA 
Connections" 
Icon.   

 

You will see that it near the clock. 

 

When you Click the ICA Icon, you will see the 
ICA connection center as seen at the left 

• Click the Security button. 
 

 

 

 

 

 

The ICA Client File Security window will open. 

• In the upper box Click FULL ACCESS  
• In the lower box Click NEVER ASK ME AGAIN FOR 

ANY APPLICATION. 
• Click OK. 

With this choice you may access the A drive or the C drive for 
any Trns•port application you work in. 

• Click OK on the ICA Connections window to complete the setup and close the ICA 
connection center. 
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You are now ready to save a 
report from Trns•port.   
In the Processes List window 
open a report and it will appear 
similar to the one seen here. 

• Click either the Save As 
Text, or Save As Rich 
Text button. 

 
 
 
 
 
 
 

• DblClick "C$ on 'Client"(V:)"  
 
 
 
 

• DblClick Documents and Settings. 
 
 
 

• DblClick the UserId or Name, depending on 
how your PC is set up. 

 
 
 

• DblClick My Documents. 
 

 

 

You should now recognize the directory structure on 
your PC.  When you reach the folder you seek, 

• Click the OPEN button to save the file. 
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